Table of Contents

1 Overview.................................................................................................................................................... 4
  1.1 General .............................................................................................................................................. 4
  1.2 Operator Inputs to Screen Forms................................................................................................. 6
  1.3 Printing Tables/Exporting Data to Excel .................................................................................... 8
  1.4 Triggering Manual Data Transfer............................................................................................... 10
  1.5 Read in alarm messages............................................................................................................... 12
  1.6 Delete statistical data.................................................................................................................... 13
  1.7 Delete statistical data from date ................................................................................................. 13
  1.8 Entering the MDA License........................................................................................................... 15

2 Functionality of the User Interfaces .................................................................................................. 16
  2.1 Starting the User Interface on a PC Running Windows NT ....................................................... 16
  2.2 Menu Bar....................................................................................................................................... 17
  2.3 Pushbuttons on the Footer ........................................................................................................... 18
  2.4 Operating the Tree View Display................................................................................................. 20
  2.5 Configuring "General Settings".................................................................................................. 22
  2.6 Configuring "Theme-related settings"......................................................................................... 24
  2.7 Configuration of the integrated plant model of MDA Cell and Machine: ......................... 24
  2.8 Configuring "Groupings": Areas/groups, Cost centers, ......................................................... 25
  2.9 Configuring “Work Centers” (Machines, Units)......................................................................... 27
  2.10 Status Conditions....................................................................................................................... 36
      2.10.1 Definition of Machine Status Conditions............................................................................ 36
      2.10.2 Configuring “MDA Status Conditions”............................................................................ 37
  2.11 Configuring “MDA Scrap Reasons” .......................................................................................... 41
  2.12 Configuring "User Groups" ......................................................................................................... 43
  2.13 Configuring "User Names"........................................................................................................... 45
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.14</td>
<td>Configuring &quot;Machine authorizations&quot;</td>
<td>48</td>
</tr>
<tr>
<td>2.15</td>
<td>Configuring the &quot;Filter for Alarm Acquisition&quot;</td>
<td>50</td>
</tr>
<tr>
<td>2.16</td>
<td>Read in ProTool alarms</td>
<td>52</td>
</tr>
<tr>
<td>2.17</td>
<td>Configuring &quot;Calculation of OEE Distinctive Numbers&quot;</td>
<td>55</td>
</tr>
<tr>
<td>2.18</td>
<td>Calculating the OEE Distinctive Numbers</td>
<td>58</td>
</tr>
<tr>
<td>2.19</td>
<td>Configuring &quot;Display of OEE Distinctive Numbers&quot;</td>
<td>60</td>
</tr>
<tr>
<td>2.20</td>
<td>Starting Without Login</td>
<td>62</td>
</tr>
<tr>
<td>2.21</td>
<td>Language Selection</td>
<td>62</td>
</tr>
<tr>
<td>2.22</td>
<td>About</td>
<td>62</td>
</tr>
<tr>
<td>2.23</td>
<td>Display Help</td>
<td>62</td>
</tr>
<tr>
<td>3</td>
<td>Configuring a Multistage Mimic Screen</td>
<td>63</td>
</tr>
<tr>
<td>3.1</td>
<td>Structure and Options in the Multistage Mimic Screen</td>
<td>63</td>
</tr>
<tr>
<td>3.2</td>
<td>Creating the Mimic Screens</td>
<td>66</td>
</tr>
<tr>
<td>4</td>
<td>Configuring Data Transfer</td>
<td>72</td>
</tr>
<tr>
<td>4.1</td>
<td>Information on Data Transfer</td>
<td>72</td>
</tr>
<tr>
<td>4.2</td>
<td>Available Transfer Modes</td>
<td>73</td>
</tr>
<tr>
<td>4.3</td>
<td>Data Transfer – Computer Names</td>
<td>74</td>
</tr>
<tr>
<td>4.4</td>
<td>Data Transfer – Database Tables</td>
<td>76</td>
</tr>
<tr>
<td>4.5</td>
<td>Transfer Jobs – Header Data</td>
<td>78</td>
</tr>
<tr>
<td>4.6</td>
<td>Transfer Jobs – SQL Statements</td>
<td>80</td>
</tr>
<tr>
<td>4.7</td>
<td>Transfer orders – Target stations</td>
<td>82</td>
</tr>
<tr>
<td>5</td>
<td>General Information on Handling</td>
<td>84</td>
</tr>
<tr>
<td>5.1</td>
<td>Information on Using the Mouse</td>
<td>84</td>
</tr>
<tr>
<td>5.2</td>
<td>The Help System</td>
<td>84</td>
</tr>
<tr>
<td>5.3</td>
<td>Traces and Error Messages</td>
<td>85</td>
</tr>
<tr>
<td>5.4</td>
<td>Adding a New Foreign Language in MDA</td>
<td>86</td>
</tr>
<tr>
<td>6</td>
<td>Product information</td>
<td>87</td>
</tr>
<tr>
<td>6.1</td>
<td>Product information &quot;Mimic screen&quot;</td>
<td>87</td>
</tr>
</tbody>
</table>
6.2  Product information "Configuring Work Centers (Machines, Units)" ...............87
7    Glossary.........................................................................................................................88
8    Index...............................................................................................................................91
1 Overview

1.1 General

This document describes the customizing of MDA in all variants (Cell, Plant, IFC or Machine). For editorial reasons some functions are described which are not part of the product MDA Cell but are intended for use within projects. These chapters are to be ignored for customizing of MDA Cell. See also chapter "Product information".

Classifying the data to be configured:

Using the "Configuration" user interface, you can create several configurations. The system gives each configuration a name.

In this way, it is possible to manage configurations for different system environments.

The system saves a portion of the parameters in a configuration-independent way, since it is not sensible to have different screen form texts in different configurations, for example.

Following configuration data impacts all variants of the configuration:

- **MDA status conditions**: Definition of the status groups and status conditions for the machines and units
- **Groupings**: Definition of areas/groups, cost centers, manufacturers, machine types
- **Work centers**: Definition of machines and units
- **Screen form texts**: Foreign language texts of all the static texts in the screen forms.
- **Message texts**: Foreign language texts of all the texts that the program outputs on the message line or elsewhere.
- **User groups**: Management of user groups
- **Filter for alarm acquisition**: Optional screen form that is only available if you are working with alarm acquisition.
- **Multistage mimic screen**: The current plant status

Following configuration data depends on the configuration variant selected:

- **General parameters**: The general parameters contain central settings for the programs and the user interfaces.
- **User Logins**: Management of user logins
- **Colors of the MDA status conditions** in the graphics
- **Menu bar**: Structure of the menu bar per user interface.
- **Toolbar**: For the optional toolbar below the menu bar, you configure which icons with which functions are to be displayed.
• **Number and labelling of function keys:**
  The number and the labelling of the function keys at the bottom and on the right of the user interfaces.

• **Assignments of function keys:**
  On a per screen form basis, you configure the assignments of the function keys at the bottom and on the right.

• **Screen forms and tables:**
  Configuring the coordinates and sizes of the individual fields on the user interfaces. You can insert new output fields in the screen forms by means of configuration.
  For tables, you can configure the displayed columns by means of a follow up screen form.

• **Data Transfer**
  All the configurations for transferring data between the group PC and the work centers

• **Languages:**
  Enables and designations of the individual languages.

Using this graphical user interface you can configure following parameters:

• General settings
• Work centers and MDA status conditions
• User groups and user logins
• Data Transfer

This configuration contains all the data which, under certain conditions, you must adapt plant-specifically for MDA.

**User groups:**
Depending on the user group, you can deactivate individual functions.
1.2 Operator Inputs to Screen Forms

You can make inputs to the user interface screen forms using the mouse or just the keyboard.

Name of the current screen form:

On Windows PCs, the system enters the name of the current screen form in the window's header.

Keyboard inputs: Keyboard Inputs

<table>
<thead>
<tr>
<th>Key</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAB</td>
<td>Moves to the next field in the screen form, including the pushbuttons in the footer.</td>
</tr>
<tr>
<td>HOME</td>
<td>Moves to the next field in the screen form, not including the pushbuttons in the footer.</td>
</tr>
<tr>
<td>F1-F8</td>
<td>Pressing function keys F1 to F8 starts the functions assigned to the pushbuttons in the footer.</td>
</tr>
<tr>
<td>R1-R8</td>
<td>Depending on the PC or Operator Panel, you execute the pushbuttons on the right-hand side using the right-hand function keys or Shift + the bottom function keys.</td>
</tr>
<tr>
<td>CTRL C</td>
<td>Copies the selected entry in Tree View to the clipboard.</td>
</tr>
<tr>
<td>CTRL V</td>
<td>Pastes the contents of the clipboard into the Tree View.</td>
</tr>
<tr>
<td>TOGGLE</td>
<td>Using the toggle key, you can select and deselect the checked rows.</td>
</tr>
<tr>
<td></td>
<td>On the SINUMERIK, the toggle key is in the middle of the arrow keys; on a PC, it is in the middle of the numeric keypad (the figure 5).</td>
</tr>
</tbody>
</table>

Colored background of the current field:

Using the general parameters, you can specify in configuration that the system gives a colored background to the active field.

The default setting is that the active field has a yellow background.

In general, the following applies:

- Fields with white backgrounds are input or selection fields
- Fields with grey backgrounds display information that you cannot alter.
Zooming the screen forms:

On Windows PCs, you can change the sizes of the screen forms. The system adapts the TreeView, tables and lists to the current size of the screen form.

Using the mouse, you can change the width of the Tree View.

See also the Chapter entitled “Operating the Tree View Display” on page 20.
1.3 Printing Tables/Exporting Data to Excel

Call the print function in the menu bar by means of: File ➔ Print

The user interface makes available two print modes:

- **Simple printing**: Printing as a hardcopy of the current screen form only
- **Enhanced printing**: Printing hardcopies and printing the data in table form and exporting the screen form data to Excel

You can switch between the two modes by configuring the general settings.

General Parameter ➔ PRJ_USER ➔ PRINT_FLAG

Values:
0 - Simple printing
1 - Enhanced printing

**Simple printing of hardcopy:**

If you trigger printing here, the system outputs to the computer's default printer a hardcopy of the current screen form as a graphic.

**Enhanced printing of tables/exporting to Excel**

In the case of enhanced printing, the system first displays a selection form.

On the left-hand side of the form, you can choose the print mode:

- **Hardcopy of the screen form**: The system outputs to the computer's default printer a hardcopy of the current screen form as a graphic. This print mode is available with all screen forms.

- **Print data in table form**: The screen form's data is printed as a table with a header and continuation sheets. This print mode is blocked if the current screen form does not support it.

- **Create export file for Excel**: The system writes the data of the screen forms to a .csv-format file. You can read this file in Excel. Exporting to Excel is blocked if the current screen form does not support it.
In the case of the "Hardcopy" and "Tables" print modes, you can choose on the right-hand side of the screen form a printer and the paper format either Portrait or Landscape.

For exporting the data to Excel, you can specify on the right-hand side of the screen form the path and the name of the export file.

Notes:

- The export file to Excel is created in .csv (Comma Separated Values) format. You can view this file in any text editor program. If Microsoft Excel is installed, you can start the program by double-clicking on the file and then you can view the data of the screen form in an Excel worksheet.

- Only some of the configuration screen forms support enhanced printing.
1.4 Triggering Manual Data Transfer

Call data transfer in the menu bar by means of:  File → Start data transfer

If data has been changed, you can transfer it by means of a configured data transfer to acquisition stations.

The system calls a data transfer like this automatically on a cyclical basis by means of a MDA background program; you can also call it manually via the configuration interface.

The system displays the following screen form:

![Manual data transfer](image)

**Operator inputs in the screen form:**

- **Transfer number:**
  Using the check box list, you can choose one or more of the defined data transfers.

- **PC name:**
  Using the check box list, you can choose one or more PCs. The data will be transferred to the selected ones.
  On selection of "* - All PCs", the data will be transferred to all PCs applied to MDA.

- **Parameters 1 - 5:**
  You don't need to configure parameters for any predefined transfer of MDA.
  Some project specific data transfers have additional parameters. If a parameter for a data transfer has been defined, the meaning of the parameter is written after the input field.
  Fill in the necessary parameters.
Clicking on "OK" starts the data transfer.

The system passes on the data transfer to the "MDETransfer" background program that carries out the actual data transfer on an asynchronous basis.
1.5 Read in alarm messages

You can use this screen form to convert SINUMERIK alarm texts of directly into the MDA database.

Call conversion in the menu bar by means of File → Apply alarm texts

In the general settings, you specify whether messages and alarms are to be acquired at all:

General Settings → MDE_SERVER → WITH_ALARM

The system displays the following screen form:

Operator inputs in the screen form:

- **Source:**
  The system stores the alarm texts under this alarm source. Choose one of the defined sources.

- **File format:**
  Select one of the defined file formats of the chosen source. In case of MMC source there exists only one file format (MMC). In case of PLC alarms source you have to select from which system the alarm texts are imported (ProTool/Pro, WinCC flexible 2005 or PLC Alarne, i. e. csv file).

- **Directory:**
  Choose the drive and the directory where the files containing the alarm texts are located.

- **File filter:**
  The default setting is that all the files are taken. Using the file filter, you can limit the files, e. g. to a specific language in MMC naming convention, e. g. UK stands for English in *_UK.csv.

- **Number of relevant parameters for alarms:**
  This parameter is relevant only for MMC. This parameter defines the maximum number of alarm parameters that are taken into account per
alarm message, when creating alarm statistics.
Example: Is the number of relevant parameters set to 1 and the channel number is stored in this one, the statistics are generated per channel number.
If an alarm message has less parameters, the system automatically takes the number of parameters of the message for this alarm message.

- **Machine:**
  Select the work centre the alarm will be collected for.

- **Alarm group:**
The system stores the alarm texts under this alarm group. Choose an available alarm group or enter the designation of a new one. While selecting a work centre (PLC alarms) the actual value is suggested. Changing the value results in an adjustment of the work centre customization.

- **Switch bit order:**
  During assigning you have to keep in mind, that the alarm number correspond to the bit position within the PLC. MDA reads the bits within a byte from the highest to the lowest bit according to the SINUMERIK HMI (e.g. DBX4.7, DBX4.6, ... DBX4.0, DBX5.7, ...). If all PLC alarms are linear ascending all the time (S7 format), then there must be a resort of the bits in MDA with “base 8 bits”.

Clicking on "Start" triggers reading in of the alarm texts.
The background program "AlarmConvert.exe" actually reads in the alarm texts.
While this program is running, the configuration interface is locked.
When the system has finished converting the alarm texts, it issues a message on the message line and you can view MDA System Logbook to see whether conversion was carried out without errors or, if not, why it was unsuccessful.

### 1.6 Delete statistical data

Call from menu bar: File → Delete statistical data

You can delete all data that has been acquired in MDA.

Deleted data can not be recovered any more! Before data will be deleted, you have to confirm, that you really want to delete all the acquired statistic data and all alarm data of all machines and units.

### 1.7 Delete statistical data from date

Call from menu bar: File → Delete statistical data from date
You can delete statistical data for individual machines from a point of time, that has to be entered.
Deleted data can not be recovered any more! Before data will be deleted, you have to confirm, that you really want to delete statistic data from date entered. Machines concerned will be listed in the confirmation message.

Data will be deleted completely for each compression level. For example, if you have entered date '2006-09-13 12:00:00', regarding compressionlevel 'year' all data of year 2006 will be deleted completely for selected machines. Moreover for compressionlevel 'month' all data acquired for month '09' will be deleted. Regarding compressionlevel 'day' all data of the '13th' will be deleted. Shift- and week compressionlevel is handled likewise.
1.8 Entering the MDA License

Call from menu bar:    File → Licensing

Use this screen form to enter the MDA license (the product key).

The system displays the following screen form:

After displaying the screen form, the system displays an existing license. If you have not yet entered a license, the screen form fields are blank.

**Operator inputs in the screen form:**

Enter your product key and then click on the "OK" pushbutton.

The system checks the product key and if it is incorrect, rejects it with a message. Correct licenses are saved.

**Pushbuttons:**

"OK": The system checks and saves the license.
"Cancel": Exits the screen form without saving the data.

**Note:**

MDA setup automatically stores the productkey to the system. You only need to enter a product key in this mask, if you want to upgrade the system.
2 Functionality of the User Interfaces

2.1 Starting the User Interface on a PC Running Windows NT

You can start the user interfaces using the Windows Start button or directly from the directory:

- Click on the Windows Start pushbutton, then: ‘Start -> Program Files -> MCIS MDA -> Customizing (User)’

After starting, the user interface displays the login screen. When you enter a valid user group and its associated password, the system displays the main screen containing the TreeView.

If you specified at configuration that the system is to start without a login screen, the user name that you entered at configuration is used and the system immediately displays the main screen.

You can switch to the individual configuration screen forms using the pushbuttons in the footer and by choosing one of the nodes in the Tree View.

The functions that you have available depend on the configured User group.

You can change the user login using function "Login Screen" on the main screen.
2.2 Menu Bar

The system displays the configuration screen forms directly after you choose an element in TreeView. You can execute all the functions using the symbol pushbuttons in the footer.

On the SINUMERIK, no menu bar is available; in this case, you make your inputs using just the pushbuttons on the footer.

Using the menu, you can only call some of the functions directly. The functions that you see in the menu depend on the current User group.

Structure of the menu if all the functions are available:

- **File**
  - Login screen: Displays the login screen to log in again
  - Print: Displays the print screen form
  - Copy entry: Copies the entry that is selected in TreeView to the clipboard
  - Paste entry: Pastes the contents of the clipboard to TreeView
  - Start data transfer: Screen form for starting a manual data transfer
    Configuration of user data only:
  - Delete statistical data: The system deletes all the statistical data of machine status-, parttype- and possibly all the alarm data of all the machines and units after prompting you to confirm deletion
  - Delete statistical data from date: The system deletes all the statistical data of machine status-, parttype- and possibly all the alarm data of the specified machines from the date entered in the mask.
  - Apply alarm texts: Call the screen form for loading alarm texts
  - End: Exits from the user interface

- **Options**
  Language: German/English/... Switches languages

- **Help**
  - Contents: Displays this help
  - About: Displays the version number of the user interface

Functions "End", "Help - Contents", "Help - About" and "Options - Language" are not available on the SINUMERIK.

See also the Chapter entitled “Operating the Tree View Display” on page 20
2.3  Pushbuttons on the Footer

At the bottom edge of the window, there are symbol pushbuttons. When you move the mouse pointer over the individual pushbuttons or use the tabulator key, the system displays a help text on the message bar that describes it in more detail. This help text shows you what actions each pushbutton triggers.

Operating the pushbuttons:

- You can operate the pushbuttons directly by pressing function keys F1 to F8.
- You can also use the mouse to operate the pushbuttons.
- You can move to one of the pushbuttons by pressing the tabulator key and then pressing Return or the space bar to "press" the pushbutton.

Appearance and labelling of the pushbuttons:

Using configuration “General Parameters → PRJ_USER (or PRJ_OEM) → BUTTON_ICON”, you specify whether the pushbuttons are labeled with text or whether the system displays icons. By default, the pushbuttons on the SINUMERIK are labeled with text and display icons on the PC and the Operator Panels.

Configuring the pushbuttons in screen forms:

Every screen form has specific functions on the footer that must be available, e.g. the OK function to save new data.

The following list contains all the available functions with the supplied icons. You can overwrite the icons with different ones on a plant-specific basis.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Label</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅</td>
<td>OK, YES</td>
<td>Saves changes and confirms prompts.</td>
</tr>
<tr>
<td>✗</td>
<td>No</td>
<td>Refuse changes and declines prompts.</td>
</tr>
<tr>
<td>🚦</td>
<td>Discard changes</td>
<td>Discard changes.</td>
</tr>
<tr>
<td>🚦</td>
<td></td>
<td>Cancels prompts for deletion etc.</td>
</tr>
<tr>
<td>⬅️</td>
<td>One screen form backwards</td>
<td>Goes back to the previous screen form.</td>
</tr>
<tr>
<td>⬅️</td>
<td>Back to main screen</td>
<td>Returns you to the main screen.</td>
</tr>
<tr>
<td>🎯</td>
<td>Select row</td>
<td>Chooses the current row in a list.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Select all rows</td>
<td>Chooses all the rows in a list. If all the rows are already selected, this reverses the selection.</td>
<td></td>
</tr>
<tr>
<td>New entry</td>
<td>Creates a new data record.</td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>Saves the data.</td>
<td></td>
</tr>
<tr>
<td>Clear</td>
<td>Deletes the data.</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the entry in TreeView with its branches to the clipboard.</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes the contents of the clipboard into the Tree View.</td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td>Deletes the entry in TreeView with its branches.</td>
<td></td>
</tr>
<tr>
<td>Delete entry</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Activate Configuration</td>
<td>Set the configuration to active. The system takes this data at the next start-up.</td>
<td></td>
</tr>
<tr>
<td>Create new configuration</td>
<td>Creates a new configuration. When doing this, the system copies the data of an existing configuration.</td>
<td></td>
</tr>
<tr>
<td>Delete configuration</td>
<td>Deletes a configuration. You cannot delete the active configuration and the &quot;DEF_...&quot; configurations.</td>
<td></td>
</tr>
<tr>
<td>Inserting a pushbutton</td>
<td>Creates a new menu pushbutton in front of the currently selected one</td>
<td></td>
</tr>
<tr>
<td>Delete the pushbutton</td>
<td>Deletes the menu pushbutton</td>
<td></td>
</tr>
<tr>
<td>Step higher</td>
<td>The system sets the menu pushbutton one step higher in the hierarchy</td>
<td></td>
</tr>
<tr>
<td>Indent</td>
<td>The system sets the menu pushbutton one step lower in the hierarchy</td>
<td></td>
</tr>
<tr>
<td>Insert new field</td>
<td>Configuration of input screen forms: Insert a new field in the screen form</td>
<td></td>
</tr>
<tr>
<td>Configuration of table columns</td>
<td>Calls the screen form for configuring the columns of tables.</td>
<td></td>
</tr>
<tr>
<td>Login screen</td>
<td>Displays the login screen to change user groups.</td>
<td></td>
</tr>
<tr>
<td>Help</td>
<td>Displays Help.</td>
<td></td>
</tr>
</tbody>
</table>

The table above lists the available actions and their corresponding descriptions within a software context, likely related to configuration management or data records.
2.4 Operating the Tree View Display

On the left-hand side of the screen form, the system displays the data of the current configuration in a TreeView.

Elements marked with a plus sign (+) have another level containing data.

The functions on the footer refer to the selected entry in TreeView. If you choose an entry for which the edit screen form is displayed, you must switch back to the main menu before the functions of the TreeView are available.

Operating TreeView with the mouse:
- Double-clicking on an entry expands or shrinks the representation.
- Clicking on the plus or minus sign (+ or -) in front of an entry opens or close the branch of the representation.
- Clicking on an entry on the bottom level displays its data on the right-hand side of the screen form where you can edit it.
- Using the mouse, you can change the width of the TreeView. To do this, place the mouse next to the right-hand edge of the TreeViews. When the mouse pointer changes to a horizontal arrow, you can press and hold down the left mouse button and drag it to change the width of the TreeView.

Operating TreeView with the keyboard:
- Using the Up and Down arrow keys, you can navigate around TreeView. The current entry is displayed with a colored background.
- If you arrive at an entry on the bottom level, the system automatically displays its data on the right-hand side of the screen form where you can edit it.
- Pressing Return on an entry expands or shrinks the representation.

Pushbuttons in the footer:

Pushbuttons that are used by the screen forms:
- **F2 function key - ‘Copy entry’**
  Copies the highlighted entry and all its branches to the clipboard. This function is not available for the following data types:
  - screen form texts, message texts
- **F3 function key - ‘Paste entry’**
  Pastes the data that you previously copied to the clipboard below the highlighted entry in the TreeView. You can also copy data between different configurations, but this must always be within the same data type. This function is not available for the following data types:
  - Screen form texts, message texts
- **F4 function key - ‘Delete entry’**
  Deletes the highlighted entry in TreeView and all its branches. This function is only available for the following data types:
  - Work centers, User groups, screen forms, MDA status conditions, data transfers
  - In screen forms, the mandatory fields are not deleted.
- **F5 function key - ‘Activate configuration’**
  Sets the configuration to active. The system takes the data of this configuration the next time it or a user interface starts up.
- **F6 function key - ‘New configuration’**
  Creates a new configuration. When doing this, the system always copies the data of an existing
configuration to the new one. You can specify in the copy screen form the name of the new configuration and the name of the configuration from which the files are copied.

- **F7 function key - 'Delete configuration'**
  Deletes a configuration with all its data.
  You cannot delete the active configuration and the “MDA_...” configurations.

- **F8 function key - 'Login'**
  Displays the login screen.

**Copy/Paste - Copying data in TreeView**

In TreeView, you can use Copy/Paste to copy data within the same configuration as well as in another one.

There are several steps to copying data:

- Highlight the entry in TreeView that you want to copy.
- Execute the Copy function.
- If necessary, load another configuration.
- Highlight the entry in TreeView below which you want to paste the data.
- Execute the Paste function.

You can execute the “Copy” function in three different ways:

- Footer: Click on the ‘Copy entry’ pushbutton.
- Menu: Choose item File → Copy entry
- Keyboard: Press the ‘CTRL’ and ‘C’ keys at the same time.

You can execute the “Paste” function in three different ways:

- Footer: Click on the ‘Paste entry’ pushbutton.
- Menu: Choose item File → Paste entry
- Keyboard: Press the ‘CTRL’ and ‘V’ keys at the same time.
2.5 Configuring “General Settings”

In TreeView, open the “General Settings” entry.

The general parameters are subdivided into several classes, e.g.:

- “GLOB” - higher level parameters
- “GUI_ANALYS” - parameters of the “MDA” user interface
- “GUI_WKAL” - parameters of the “works calendar” user interface
- “MDE_COMPRESS” - Parameters of the compression process
- “PRJ_USER” - Parameters of the “Configuration of user data” user interface

Open the desired class. The system displays in TreeView the key names of the parameters.

When you choose a key name, the system displays the edit screen form for the global parameters.

Data of the screen form:

The values of the parameters are dependent on the configuration. Changes only take effect when you make them in the active configuration or activate this configuration.

The system displays the following data in the screen form:

- **Name parameter:** Key name of the parameter, cannot be changed.
- **Value parameter:** Current value of the parameter
- **Language of the comment:** Drop-down list containing the available languages
• **Comment on parameter:**
  Below this, there is the comment to the parameter. The comment describes the parameter and its possible values.
  You can change this text and translate it to other languages, for example.

**Operator inputs in the screen form:**
Set the value of the parameter as desired and if necessary edit the comment appropriately.
Clicking on "OK" triggers storing of the data. The system checks the value of the parameter for plausibility. Incorrect values are refused and the system displays an appropriate message on the message line.

**Pushbuttons in the footer:**
Pushbuttons that are used by the screen forms:
  • F2 function key  -  ‘OK’  Saves the parameter data
  • F8 function key  -  ‘Back to main screen’

For a description of the general parameters, refer to the Chapter entitled “Configuring "General Settings"” on page 22
2.6 Configuring "Theme-related settings"

By using this mask, you can edit general parameters, corresponding to one theme. These parameters are displayed in one grid. The advantage of this method is that all corresponding parameters can be seen in one display.

Data of the screen form:
On startup all relevant parameters corresponding to node selected in tree node are displayed in the grid.

Operator input to the screen form:
Parameter referring to more than one node are coloured red. The parameter value can be updated in the edit row below the grid.

After clicking button "OK" parameter values will be confirmed to the database.

Pushbuttons in the footer:
Pushbuttons that are used by the screen forms:
- F2 function key - 'OK' Saves the data
- F8 function key - 'Back to main screen'

2.7 Configuration of the integrated plant model of MDA Cell and Machine:

By means of the configuration interface the following parameters in the integrated, one level plant model can be set centrally in the "General Parameters":
• General Parameters > GUI_RT > LAYOUT_BITMAP
  Filename of the background bitmap for the plant diagram. If the data is not located in the bitmap
directory, which is entered into the parameter "GUI_RT → PATH_BITMAPS", then an absolute path
name will have to be given.

• General Parameters > GUI_RT > LAYOUT_HEIGHT and LAYOUT_WIDTH
  Height and width of the symbols for the stations in Pixels.
  All symbols have the same size.

• General Parameters > GUI_RT > LAYOUT_WITHSTATUSNAME
  Flag whether the status text should be given under the symbol.
  The status text will be shown either by all symbols or none.

The position of the symbol in the plant diagram at the configuration of the stations can be set for each
machine/unit. If the position "0/0" is specified, then the machine/unit will not be displayed in the plant
diagram.

2.8 Configuring "Groupings": Areas/groups, Cost centers, ...

Functionality of MDA Plant.

Open the "groupings" entry in TreeView.

For the multistage mimic screen and for future evaluations in MDA, you can define groupings and assign
each machine to these groupings: machines can be assigned to an area and a group, to a cost center, to
a manufacturer and to a machine type.

In this screen form, you define the groupings.
In the screen form in which you define the work centers, you assign the machines to the groupings.

Open the desired grouping. TreeView shows all the defined entries.

In the "Area/Groups" grouping, you can additionally choose an area in TreeView and see below it the
groups that are defined in this area.

If you select an entry, the system displays its data in the screen form.

Screen form for groups/areas:
Operator inputs in the screen form:
If you want to define a new area, enter the area designation and leave the group designation blank.
To define a new group within an area, enter the area and group designations.
The area and group designations can be a maximum of seven characters long.
In the fields below them, you can specify a long text for each language consisting of a maximum of 30 characters. This long text is used in the pick lists of the groupings in other screen forms.

Save your data using the "F2 - OK" pushbutton.

Screen form for cost centers, manufacturer and machine type:

Operator inputs in the screen form:
If you want to define a new cost center, a new manufacturer or a new machine type, enter the designation (maximum of 15 characters).
In the fields below them, you can specify a long text for each language consisting of a maximum of 30 characters. This long text is used in the pick lists of the groupings in other screen forms.

Save your data using the "F2 - OK" pushbutton.

Pushbuttons in the footer:
Pushbuttons that are used by the screen forms:
- F2 function key - ‘OK’ Saves the data
- F4 function key - ‘Delete entry’
2.9 Configuring “Work Centers” (Machines, Units)

Open the “work centers” entry in TreeView.

In MDA, a machine is classified by the following data:

- **WERK**
  The four-digit WERK (plant) identifier is for grouping machines that are all located in the same plant or shop.

- **PDA group**
  The machine can be assigned to a group.

- **MASCHINE**
  Machines can consist of several units. One unit is defined as the “main unit” and it represents the status of the entire machine.

- **AGGREGAT**
  In addition to the main unit, each machine can have several units that represent sections of the machine, e.g. feed conveyor, pendulum grinder, etc.

The system outputs the machines hierarchically sorted by plant and MDA group. Depending on the license, each machine can have several units.

Open the desired plant and in the plant the desired MDA group. In the TreeView, the system displays all the machines of this MDA group. If you select a machine, the system shows its units.

You display the parameterization screen form by choosing a machine or a unit. If no machines at all are defined, the system displays the parameterization screen form when you select the “work centers” entry.
Data of the screen form:
The machines and units do not depend on the active configuration and therefore apply to all the configurations.

- **APLZ_Nr:**
  If you configure a station on the MDA host computer, the system displays the work center number, "APLZ_Nr", as the top field.
  Users cannot enter this number; the user interface assigns it internally. In the case of new machines and units, it is set to the lowest free APLZ-Nr.

**Identification of the station:**

**Plant, PDA group and machine, Name of NCU:**
These are the machine's keys.
If you define a new machine, you uniquely specify these designations for your machine. It is not possible to change later the plant and PDA group keys.

**Name of NCU:**
The NCU name is necessary for SINUMERIK with more than one NCUs. If only data for one (default) NCU are collected the field may be empty. The NCU name will not be checked during collecting data then.

**Designation:**
Identification of the machine in the screen forms and evaluations.

**Type of the station:**

- **Main unit / sub-unit to machine:**
  Here, you specify whether you want to define
  – a machine (main unit) or
  – a unit of a machine (sub-unit)
  If you define a unit assigned to a machine, you must choose from the pick list the designation of the machine to which the unit belongs.
  If a main unit has one or more sub-units assigned to it, you can no longer redefine it as a sub-unit.
Assignments of the station:

This section contains the assignments of the machine to status groups, works calendar, etc.

- **Status group:**
  This pick list is always available.
  Number of the status group of the machine.
  The status conditions for machines and units are configured in status groups. Each machine and each unit must be assigned to exactly one status group.
  Before configuring a machine or a unit, you must have configured at least one status group.

- **Alarm group**
  This pick list is only available if you are working with alarm/message acquisition:
  General Settings → MDE_SERVER → WITH_ALARM
  The alarm and message numbers are configured in alarm groups.
  If this pick list is visible, the following applies:
  - Each machine and each unit must be assigned to exactly one alarm group.
  - Before configuring a machine or a unit, you must have configured at least one alarm group.

- **Scrap group**
  Scrap groups are supported in MDA Plant only. Only this product provides detailed specifications of reasons of scraps.

- **Operation status group:**
  Is only relevant when connected to SAP. Enter the identification of the statusgraph of the SAP operations running on actual machine.

- **Activity group:**
  Is only relevant when connected to SAP. Machines with equal activities can be grouped to one activity group.

- **Working time model:**
  This pick list is only available if you are working with a works calendar:
  General settings → GLOB → WITH_SHIFT
  In the works calendar, you configure working time models.
  If this pick list is visible, the following applies:
  - Each machine and each unit must be assigned to exactly one working time model so that the system can acquire the status conditions on a shift-specific basis.
  - Before configuring a machine or a unit, you must have configured at least one working time model.
• **computer name:**
  For linking MDA to the host computer MDA, you must enter for each station the computer name of the MDA computer at which the controller accepts the data of the station.

• **Reservefeld:**
  Is only relevant when connected to SAP.

• **Positioning the mimic screen**
  The evaluation GUI MDA Cell and MDA Machine provides a simple plant model. Here you configure the position of the machine symbol in this one. These parameters are irrelevant for the multi stage plant model of MDA Plant.
### Acquisition:

<table>
<thead>
<tr>
<th>Identification</th>
<th>Assignments</th>
<th>Acquisition</th>
<th>Groupings</th>
<th>MCIS Web</th>
<th>ERP data</th>
</tr>
</thead>
</table>

- **Type of automatic acquisition**
  - MDC acquisition

- **Data block**
  - Cluster: 1
  - Position: 1

- **Cycle time**: 60
- **Maximal no. of operations**: 1
- **Cycle factor**: 1
- **Maximal no. of persons**: 1
- **Maximal no. of planned operations**: 0
- **Tolerance range counter overflow**

### Automatic acquisition:

Using the automatic acquisition field, you set the data that the machine is to acquire.

**MDC**: Machine status conditions and total piece counts

**PDC**: Part type-specific piece counts and cycle times

You can combine the two by choosing "MDC + PDC".

"No acquisition" is appropriate for manual work centers without automatic acquisition.

"locked" work centers are not released for acquisition of data, e.g. work centers, which are already customized in MDA system, but don’t exist physically yet.

### Data block:

The customizing of data blocks is relevant for working centers with automatic acquisition (MDC plus/or PDC) only.

The controller takes status bits and other data of each machine and each unit via blocks in data blocks. You specify the names and addresses of the data blocks and the blocks in the data in the "PIT_xxxx.ini" file.

- **Cluster**:
  - At a data collection PC, several working places can be connected to. These have to be numbered in sequence for each data collection PC starting with "1".

- **Position**:
  - In standard MDA you have to enter number "1".

### Cycle time:

Planned cyctime of the machine

### Cycle factor:

Conversion factor from unit of PLC cycle time to seconds.

**Example**: If the PLC confirms cycle times in tenth of seconds, you have to enter value "0.1". If cycle time is already acquired in seconds, you must enter "1".

### Maximal no. of operations:

Is only relevant when connected to SAP. Enter the maximum number of concurrently running operations with on the machine.
Maximal no. of persons:
Is only relevant when connected to SAP. Enter the maximum number of concurrently persons applied to the machine.

Maximal no. of planned operations:
Is only relevant when connected to SAP. Enter the maximum number of planned operations allowed on acquisition pc.

Tolerance range counter overflow:
Tolerance range counter overflow is used to detect a PLC counter reset. Not until the new counter value is less than the old value minus this configured value MDA assumes that the PLC counter was reset. In this case the new value will be added to the old value completely.
Groupings:

<table>
<thead>
<tr>
<th>Identification</th>
<th>Assignments</th>
<th>Acquisition</th>
<th>Groupings</th>
<th>MIS Web</th>
<th>ERP data</th>
</tr>
</thead>
</table>

Area: Line1
EV partner: ISM1
Cost centre: Cost centre A1
Manufacturer: Manufacturer A1
Machine type: Machine Type A1
Group: Line1_M1+M2

Groupings are optional assignments of the machine to areas, cost centers, etc. These assignments are used with the multistage mimic screen with area symbols; in future, they will be used with evaluations as selection criteria with stations.

You configure the groupings themselves using the configuration interface via "Groupings".

- **Area/group:**
  As required, choose the area and the group that you want to assign to the machine or the unit.

- **EV Partner:**
  Partner of communication on side of MDA cell. Default value: ISM1.

- **Cost centre:**
  Assign the work centre to a cost centre. Previously, the const centre must be defined in this customizing gui in tree node 'Groupings'. Then you can select it from the drop down list.

- **Manufacturer:**
  Assign the work centre to a manufacturer. Previously, the manufacturer must be defined in this customizing gui in tree node 'Groupings'. Then you can select it from the drop down list.

- **Machine type:**
  Assign the work centre to a machine type. Previously, the machine type must be defined in this customizing gui in tree node 'Groupings'. Then you can select it from the drop down list.
MCIS Web:

- **Products:**
  This machine is relevant for all checked MCIS products.

- **Group name:**
  Defines the position among the tree levels of web applications. Customize designation of the group name the machine will be assigned to.

ERP Daten:

This tab sheet is only relevant for MDA Plant.

- **Activity 1 to 6:**
  Is only relevant when connected to SAP.

- **Record type:**
  Is only relevant when connected to SAP.
• **SAP Activity:**
  Is only relevant when connected to SAP.

**Operator inputs in the screen form:**
In the case of already defined machines, you cannot change the key names of the machine and the units (plant, PDA group).

Using the pushbuttons on the footer, you can define new machines and units and status groups and also delete machines and units that are no longer needed. When carrying out deletion, the system asks whether you just want to delete the data of the machine or unit, or whether you also want to delete all the statistical, log and alarm data of this machine or unit.

Clicking on "OK" triggers storing of the data. In this connection, the system checks the data for plausibility. Incorrect values are refused and the system displays an appropriate message on the message line.

**Pushbuttons in the footer:**
Pushbuttons that are used by the screen forms:
- F2 function key - 'OK' Saves the data
- F3 function key - 'New machine/unit'
- F4 function key - 'Delete machine/unit'
- F8 function key - 'Back to main screen'

See also chapter entitled Product information "Configuring Work Centers (Machines, Units)" on page 87.
2.10 Status Conditions

2.10.1 Definition of Machine Status Conditions

You define status conditions using configuration.

Status conditions are grouped in "status groups". A status group is assigned to each machine and each unit in the configuration. You use the status group to indicate for each machine and each unit the status conditions that they can take on.

There are two classes of status conditions:

- Automatic status conditions
  The controller automatically acquires the start and end of these status conditions.

- Manual status conditions
  You can only set and end these status conditions via the user interfaces of MDA Machine or MDA IFC. Only one manual status condition can pend concurrently. If a new manual status condition is set, the old one will be finished automatically.

The following status conditions must be present in every status group. You can freely assign the number of the status, the priority and the designation, the symbolic name must be included:

- Symbolic name: $MAN_AUTO
  Designation: Manual status OFF

- Symbolic name: $OFFLINE
  Designation: Machine switched off

- Symbolic name: $DEFAULT
  Designation: Default

Each status condition a priority is assigned to. The lower the number, the higher the priority of the status.

Within one status group, you can define the status conditions as main and sub-status conditions.

Each status is defined by a number consisting of five or more digits. Main status conditions are always a multiple of 10,000. The last four digits define the sub-status condition with the digits before it defining the main status condition (status class).

Example:

<table>
<thead>
<tr>
<th>Status no.</th>
<th>Status type:</th>
<th>Status text</th>
</tr>
</thead>
<tbody>
<tr>
<td>40000</td>
<td>Main status</td>
<td>Disturbance</td>
</tr>
<tr>
<td>41010</td>
<td>Sub-status</td>
<td>Order missing</td>
</tr>
<tr>
<td>41020</td>
<td>Sub-status</td>
<td>Material missing</td>
</tr>
<tr>
<td>42010</td>
<td>Sub-status</td>
<td>Tool breakage</td>
</tr>
<tr>
<td>42020</td>
<td>Sub-status</td>
<td>Oil loss</td>
</tr>
</tbody>
</table>

On every machine there can pend maximum one manual status condition and several automatic status conditions concurrently. Only the status condition with the highest priority will be considered, when statistical data (shift, week, month, year) will be created.
2.10.2 Configuring “MDA Status Conditions”

Open the “MDA status conditions” entry in TreeView.
The system displays all the defined status groups.
Open the desired status group. The system displays all the defined status conditions of this status group.
You display the parameterization screen form by choosing a status.
If no status conditions at all are defined, the system displays the parameterization screen form when you select the “MDA status conditions” entry.

Data of the screen form:
The status conditions do not depend on the active configuration and therefore apply to all the configurations.
By contrast, the status colors are saved in a configuration-dependent way, i.e. you can create different configurations that have different colors.

• Status group and status number:
These are the status's keys.
If you define a new status, you uniquely specify the status group and the status number. It is not possible to change the keys later.
You should assign a status group to each work center. These status groups can be defined by this mask. In MDA there are main- and sub-status conditions. Sub-status conditions must be assigned to a main-status conditions. The number of the status condition implicitly indicates, if it is a main- or sub-status condition: main-status conditions are always a multiple of 10.000, that means, they ends
with four zeros at least. Sub-status conditions are not a multiple of 10.000 and the number is at most 9.999 more than the associated main-status condition.

- **Priority**
  Priority of the status. The lower the number, the higher the priority of the status. Only the status condition with the highest priority (=lowest value) will be taken into consideration when creating MDA statistics.

- **Group priority:**
  The multistage mimic screen (MDA Plant) uses the group priority if area symbols are displayed. The lower the number, the higher the group priority of the status. Using the group priority, you can specify the desired priority of the status conditions above and beyond status groups for symbols for which the system displays several stations with different status groups.

- **Symbolic Name:**
  Using the symbolic name, you specify how the status can be set, see below.

- **PLC-status:**
  When currently customized status starts, this status will be set in the PLC in DB13. Therefore it is necessary to enlarge the DB13.

- **Relevant for alarm statistics:**
  Normally the statistical data compression for alarms is independent of machine status conditions. With this flag you can determine, that only alarms will be compressed, which are caused by a machine standstill. The associated machine standstill conditions are define by this flag. For the affected machines only alarms will be compressed with a start time within a time period around the start time of such a selected status. As a second criterion this status must be pending for a minimum time span. Both time periods are configured in Theme related settings for alarm acquisition.

- **Manual status conditions to be finished if status goes:**
  When currently customized status finishes, all entered pending manual statuses are automatically finished, too. You have to list the ‘Symbolic name’ of the status. Multiple manual statuses are to be separated by comma.
  Use case: Giving a reason for downtime without reason. The automatically acquired status downtime without reason is abgelöst with a higher prior manual status (e. g. tool defective). This manual status should be finished automatically when the downtime without reason is finished.

- **Manual status conditions to be finished if status comes:**
  When currently customized status begins, all entered pending manual statuses are automatically finished, too. You have to list the ‘Symbolic name’ of the status. Multiple manual statuses are to be separated by comma.
  Use case: Manual status maintenance shall be finished automatically when product signal is pending again.

- **Belated reason of disturbance:**
  When currently customized status pends, there can be entered one or more of the manual statuses as reason of disturbance belated. You have to list the ‘Symbolic name’ of the status. Multiple manual statuses are to be separated by comma.

- **Designation of the status:**
  Pick lists to specify the language of the status texts shown below it.

- **Color in the graphics:**
  Using the three sliders or by directly entering the RGB values, you define the color in which the system displays this status in the “status analysis” and “availability” evaluations, see below.

**Symbolic name:**
Using the symbolic name, you specify how the status can be set.

- **Bit_nnn**
  “nnn” represents a number between 1 and 128: The system takes the status from the specified bit in the data block in the controller (SINUMERIK, S7, etc.)
• $MAN_nnn
  Defines a manual status. "nnn" stands for a free designation.
  You can set the manual status conditions via a condition on the MDA.

• $MAN_AUTO
  Defines a special manual status. If you choose this manual status, the system ends all the manual status conditions and the automatically acquired status conditions apply again on an exclusive basis.
  You must define this status in every status group.

• $OFFLINE
  Defines the "Machine switched off" status. The MDA server sets this status at start-up for the period of time since the last status message.
  You must define this status in every status group.

• $DEFAULT
  Defines the default status. The MDA server sets this status at start-up as the current status. The status is retained until a manual or automatic status is reported.
  You must define this status in every status group.

• $XXX_nnn
  This defines a main status condition that is not set manually or automatically; rather, it is defined only to subdivide status conditions. "nnn" represents a free designation.

Every status must be given a unique symbolic name. When you save the status, the system checks whether the symbolic name already exists and if so rejects it with an appropriate error message.

Note:
Status numbers above 800,000 are reserved and are not permitted to be assigned.

Creating a new status group:
There are two ways to create a new status group:
• Directly in TreeView:
  Copy a status group and paste it together with the desired new status group number.
• In the edit screen form:
  Create a new status and enter in it the new status group number. This inserts a new branch containing this status group in the TreeView.

Setting the colors:
You define the colors as RGB (red, green, blue) colors.
Each slider represents a color fraction:
  – Red   top slider
  – Green middle slider
  – Blue  bottom slider

Keep moving the sliders until you see the color you want below them.
Note: The easiest way to get clean colors is to leave the setting of the top and the middle sliders or the top and the bottom one on 0 or 255 and just change the other slider.
Operator inputs in the screen form:
Using the pushbuttons on the footer, you can define new status conditions and status groups and also delete status conditions that are no longer needed.
Clicking on "OK" triggers storing of the data. In this connection, the system checks the data for plausibility. Incorrect values are refused and the system displays an appropriate message on the message line.

Pushbuttons in the footer:
Pushbuttons that are used by the screen forms:
- F2 function key  - ‘OK’ Saves the data
- F3 function key  - ‘New status’
- F4 function key  - ‘Delete status’
- F8 function key  - ‘Back to main screen’

See also the Chapter entitled Configuring "Calculation of OEE Distinctive Numbers" on page 55
Calculating the OEE Distinctive Numbers on page 58
Definition of Machine Status Conditions on page 36
2.11 Configuring “MDA Scrap Reasons”

Functionality of MDA Plant.
Open the “Scrap Reasons” entry in TreeView.
The system displays all the defined scrap reasons.
Open the desired group of scrap reasons. The system displays all the defined scrap reasons of this scrap group.
You display the parameterization screen form by choosing a scrap reason.
If no scrap reasons at all are defined, the system displays the parameterization screen form when you select the “Scrap Reason” entry.

Data of the screen form:
The scrap reasons do not depend on the active configuration and therefore apply to all the configurations.

- **Groups of scrap reasons and scrap reasons:**
  These are the scrap reason's keys.
  If you define a new scrap reason, you uniquely specify the group of scrap reason and the scrap reason number. It is not possible to change the keys later.

- **Identification Acquisition**
  The scrap reason is identified by this key when automatically acquired.

- **Identification GUI**
  The scrap reason is identified by this key when displayed in the graphical user interface.

- **Identification SAP**
  When scrap reason is acquired the counter will automatically added to specified counter in MDA.

- **Add scrap counter to**
  The scrap reason is identified by this key when confirmed to SAP.
• **Color in the graphics:**
  Using the three sliders or by directly entering the RGB values, you define the color in which the system displays this scrap reason in the “scrap reason analysis” evaluation.

**Creating a new group of scrap reasons:**
There are two ways to create a new group of scrap reasons:

- **Directly in TreeView:**
  Copy a group of scrap reasons and paste it together with the desired new scrap group number.

- **In the edit screen form:**
  Create a new scrap and enter in it the new scrap group number. This inserts a new branch containing this scrap group in the TreeView.

**Setting the colors:**
You define the colors as RGB (red, green, blue) colors. Each slider represents a color fraction:

- **Red** top slider
- **Green** middle slider
- **Blue** bottom slider

Keep moving the sliders until you see the color you want below them.
Note: The easiest way to get clean colors is to leave the setting of the top and the middle sliders or the top and the bottom one on 0 or 255 and just change the other slider.

**Operator inputs in the screen form:**
Using the pushbuttons on the footer, you can define new scrap reasons and groups of scrap reasons and also delete scrap reasons that are no longer needed.
Clicking on "OK" triggers storing of the data. In this connection, the system checks the data for plausibility. Incorrect values are refused and the system displays an appropriate message on the message line.

**Pushbuttons in the footer:**
Pushbuttons that are used by the screen forms:

- **F2 function key** - 'OK' Saves the data
- **F3 function key** - 'New scrap reason'
- **F4 function key** - 'Delete scrap reason'
- **F8 function key** - 'Back to main screen'
2.12 Configuring "User Groups"

Open the "user groups" entry in TreeView.
The system displays all the available user groups.
You display the parameterization screen form by choosing an user group.

General:
Each user interface has access rights for each screen form. The access rights specify whether a user is allowed to open the screen form.

The MDA user interface
If users do not have access rights to a screen form, they do not see the menu entry for this screen form and the system does not display the pushbutton in footer.

Configuration User Interfaces
If users do not have access rights to an edit screen form, they can open the subtree in TreeView; however, instead of displaying the edit screen form the system issues a message.

Data of the screen form:
You specify the user groups independently of the configuration.

It is possible to assign different privileges for every user interface. Every privilege is linked to a screen form or to a function and specifies whether the user group can use this screen form.
- **User group**: Name of the user group
  The name of the user group is specified when you create a new user group and you cannot change it.

- **Screen forms of the user interface**:  
  Using this pick list, you switch to the privileges of the respective user interface.

- **Permitted screen forms**:  
  This list displays all the privileges of the respective user interfaces. The privileges that have a checkmark are activated for the user group.

**Exceptions:**
- User ‘Administrator’ always has all the privileges on the ‘configuration’ user interface.
- It is not possible to delete user ‘Administrator’.

This makes it impossible to withdraw privileges or delete user groups by mistake such that afterwards it is not possible to use the configuration interface any more.

**Operator inputs in the screen form:**
Set for one user group all the desired privileges for all the user interfaces and save the privileges by clicking on the “OK” pushbutton.

Using the pushbuttons, you can delete user groups and define new ones.

In the list you select/deselect the individual screen forms as follows:
- By clicking on the check box next to the designation of the screen form.
- By clicking on the designation of the screen form of the currently selected row.
- By selecting a screen form either by clicking on it or using the Up or Down cursor keys and then pressing the space bar.
- Pressing the ‘Select row’ pushbutton (F5 function key) checks/unchecks the currently selected status in the list.
- By pressing the toggle key. On the SINUMERIK, this key is in the middle of the block of cursor keys and on a PC it is the figure 5 on the numeric keypad (if you do not press the NUMLOCK key).

**Pushbuttons in the footer:**
Pushbuttons that are used by the screen forms:
- F2 function key - ‘OK’ Saves the data
- F3 function key - ‘New entry’ Defines a new user group
- F4 function key - ‘Delete’ Deletes the user group
- F5 function key - ‘Select row’ Selects/deselects a row in the list
- F6 function key - ‘Select all’ Selects/deselects all the rows in the list
- F8 function key - ‘Back to main screen'
2.13 Configuring "User Names"

Open the "user names" entry in TreeView.
The system displays all the available user names.
You display the parameterization screen form by choosing a user name.

Data of the screen form:
The values of the parameters are dependent on the configuration. Changes only take effect when you make them in the active configuration or activate this configuration.
You can define new users and delete existing ones that are no longer needed.

You must not delete user "Administrator"!

- **User login**: the user's login identifier
  The user login is specified when you create a new user and cannot be changed.

- **Password**: You can change the password in this screen form.

- **Comment**: Comment for the user. The comment is displayed only in this screen form.

- **User group**: You use this pick list to assign an user group to the user.
• **Start picture for the mimic screen:**
  For MDA’s multistage mimic screen, you can assign a separate start picture to each user. This makes it possible for users to only see their individual mimic screen picture.
  If you choose "Take start picture from 'general settings'" in the pick list, the system does not store a separate start picture for the user and at start-up of the mimic screen the user gets the main screen from the "General settings of the mimic screen".

• **SQL conditions:** for MDA Plant functionality
  You can assign up to 99 SQL statements or SQL conditions to each user. The input is made by means of the fields below the list:
  – In the field at the front, you enter the number of the SQL condition (1 - 99)
  – In the field at the back, you enter the SQL text.
  The SQL conditions are only relevant, if in the general settings parameter GLOB -> MA_PRESELECT is set to value "2".

**User-specific plant view:**
Parameters 'MA_PRESELECT' (MDA Customizing User -> General parameters -> GLOB) defines the way of giving authorization for machine data:

MA_PRESELECT = ‘1’ (MA_GROUP):
For the evaluations only those machines are taken into consideration, that are released for current user and current client PC. Authorizations for machine data is customizable in "MDA Customizing User -> machine authorizations". You can give authorizations to user and client PCs. If customizing is omitted, each user and client is authorized for all machine data.

MA_PRESELECT = ‘2’ (USER_SQL):
For retrieving machine data from database, WHERE-clause, customized in "MDA Customizing User -> User names -> SQL conditions" is taken into consideration for MDA evaluations.

In "MDA Customizing User -> General Parameters -> SQLNR_USER_APLZ" you can define the number of the SQL-Statement, that contains the WHERE-clause for user specific plant view, usually number ‘10’.

In the customizing for the MDA user names, you can provide a SQL-statement for each user. For the user-specific plant-view, in the defined number above, there has to be a WHERE-clause for a selection to table APLZ_STAMM. This one contains the customized machines and units.

For example: ‘WERKS = ‘MECH’ and GRUPPE like ‘4832%’
Then, in the evaluations of MDA , the user only sees data of machines and units corresponding to this selection.

**Operator inputs in the screen form:**
Specify for a user name the login identifier, the password and the user group and then store the user by clicking on the OK pushbutton.

Using the pushbuttons, you can delete users and define new ones.

**Pushbuttons in the footer:**
Pushbuttons that are used by the screen forms:

- **F2 function key** - ‘OK’ Saves the data
- **F3 function key** - ‘New entry’ Defines a new user
- **F4 function key** - ‘Delete’ Deletes the user
- **F8 function key** - ‘Back to main screen’
2.14 Configuring "Machine authorizations"

In this configuration mask you can assign permissions for evaluations on particular acquiring workstations. It is possible to assign permissions to MDA-users and/or to evaluation clients.

Operator inputs in the screen form:
First you specify the type of permission by selecting the radio button: either permission for MDA-user or evaluation client. In the combobox you have to enter the MDA-user name or the name of the client pc that you want to assign permissions. Then you select the acquisition stations that you want to assign. If you want to assign unrestricted permission on data of all workstations you have to delete the configuration for user/client pc. This is done by triggering function "delete entry". If there is no entry for a MDA-user or client pc, the user is allowed to evaluate data of all workstations. This is very useful for customers, who don't restrict permissions by "MDA authorization" expand their plant. They do not need to update the machine authorizations. As long as you don't configure anything default permissions are active: everyone is allowed to see all data of all work centers on every pc. If there are configured permissions for both MDA-user and evaluation pc, in the evaluations there are provided only workstations fullfilling both restrictions. They must be assigned to the user and to the client pc.

Changes have to be saved by clicking button "OK".

Pushbuttons in the footer:
- function key F2 - 'OK' saving data
- function key F3 - 'Cancel' discards changes
- function key F4 - 'Delete' delete entry, deletes assignment of user/client pc to specific workstations
- function key F5 - '(de-)select workstations' (un-)check selected workstation
- function key F6 - '(de-)select workstation' (un-)check all workstations
- function key F8 - 'Back to main mask'
2.15 Configuring the "Filter for Alarm Acquisition"

This screen form is only relevant in plants in which controllers acquire messages and alarms. You use this configuration screen form to configure the filter describing the messages and alarms that are to be taken into MDA.

In the general settings, you specify whether the system is to acquire messages and alarms at all:

General Settings → MDE_SERVER → WITH_ALARM

The configuration interface only shows configuration of the alarm filter if "WITH_ALARM" is set to 1.

In TreeView, open the "Filter for alarm acquisition" entry. The system displays in TreeView all the available alarm groups and, as sub-entries, all the available data sources for alarms and messages.

After you choose one of the entries, the system displays the screen form.
Data of the screen form:
The alarm filters are stored independently of the configuration.

- **Alarm group and source:**
  Selected entry from TreeView

- **From - To:**
  The lowest and highest available number of the alarms and messages.
  The number range that is displayed in the list.

- **Error messages:**
  A list containing all the alarms and messages of the selected alarm group and source whose
  numbers are in the specified number range.

- **Data for the message:**
  The system displays below the list the optional additional data to the message that you selected in
  the list:
  - User information file
  - Relevant parameters
  - "Requires acknowledgement" flag

Operator inputs in the screen form:
Use TreeView or the fields on the left-hand side of the screen form to choose the alarm group, the source
and a number range.

Select messages in the list:

- Using the list, you can select or deselect individual messages. The system only wardrobe acquires
  the messages that are selected.

- Using the F6 function key, you can select or deselect all the messages, which allows you to change
  a complete number range at once.

Changing the properties of a selected message:

- **Relevant parameters:**
  Here, you check the number of parameters of this message that the system is to consider.
  The system rates two messages as different if either the message numbers are different or the
  message numbers are the same and differ by virtue of one of the relevant parameters.
  This parameter only impacts the compression to statistic data – not the acquisition. That means, in
  the alarm logbook and the alarm log all alarms occurred are stored.
  When statistic data is created, for every alarm source, alarm number and the number of relevant
  parameters on account is kept. This account stores duration and number of alarms occurred.
  For example: If the number of relevant parameters is "1" all alarms which differs in parameters 2 to 8
  are booked to one account.

Pushbuttons in the footer:
Pushbuttons that are used by the screen forms:

- F2 function key - ‘OK’ Saves the data
- F4 function key - ‘Delete messages’ Deletes all the displayed messages
- F5 function key - ‘Select message’ Selects/deselects messages
- F6 function key - ‘Select all messages’ Selects/deselects all the messages
- F8 function key - ‘Back to main screen’
2.16 Read in ProTool alarms

If there are acquired ProTool alarms for multi-machines in MDA, exported texts and ProTool disturbance and operation messages have to be adopted in two steps.

In the first step the alarm texts must be read in to temporary alarm group 'AL_TMP' by using mask 'Read alarm messages'.

In the second step these alarms must be assigned to one or more workstations of OSF. This is done by using this mask.

Properties of alarmtexts created by ProTool:
There is missing a direct relation of the messages to the workstation. There is an indirect relation due to the range of the alarm numbers.
In ProTool it is possible to customize identical numbers for different operation- or disturbance messages on every workstation. Example:

Workstation 1: operation messages numbers 1 – 16
Workstation 1: disturbance messages numbers 1 - 16

Every workstation has its own range of numbers for its messages. Example:

Workstation 1: messages numbered 1 –16
Workstation 2: messages numbered 17 – 32
Workstation 3: messages numbered 33 – 48

This even applies, if the workstations are identical in relation to its alarms. For example: alarmtexts 1-16 are identical with those from 17 – 32 and 33 – 48.

To transform these alarms to structure of MDA, there is a database table named AL_MACH_NUM. With input of following window the alarmtexts of temporary alarm group AL_TMP are assigned to a regular MDA alarm group in AL_TEXT.
Data of the screen form:
On left side the alarm texts of the temporary alarm group AL_ID = AL_TMP and AL_SRC = ProTool multi-
machine are displayed.

By selecting a workstation
Input of number from and number to for the ProTool alarm texts
Selection of an alarm group
Input a start number

You define, which machine and which alarm group the ProTool alarm texts are assigned to.

Example:

<table>
<thead>
<tr>
<th>Workstation:</th>
<th>1</th>
<th>Alarm group:</th>
<th>AL_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>from:</td>
<td>1</td>
<td>Start number:</td>
<td>101</td>
</tr>
<tr>
<td>to:</td>
<td>8</td>
<td>End number:</td>
<td>108</td>
</tr>
</tbody>
</table>

After submission the input data by clicking function 'OK', following entries in database are created:
The alarm number 1 to 8 of alarm group AL_TMP are assigned to alarm group AL_1 with numbers 101 to 108. The alarm with number 1 to 8 of alarm group AL_TMP are deleted.
In table AL_MACH_NUM following entries are done:

<table>
<thead>
<tr>
<th>APLZ_NR</th>
<th>SRC_AL_NUM</th>
<th>MESS_FLAG</th>
<th>MDA_AL_NUM</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>2</td>
<td>101</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>2</td>
<td>102</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>2</td>
<td>103</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>2</td>
<td>104</td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>2</td>
<td>105</td>
</tr>
<tr>
<td>1</td>
<td>6</td>
<td>2</td>
<td>106</td>
</tr>
<tr>
<td>1</td>
<td>7</td>
<td>2</td>
<td>107</td>
</tr>
<tr>
<td>1</td>
<td>8</td>
<td>2</td>
<td>108</td>
</tr>
</tbody>
</table>

**Pushbuttons in the footer:**

Pushbuttons used by this screen

- function key F2 - 'OK' read in alarm texts
- function key F8 - 'Back to main screen'
2.17 Configuring "Calculation of OEE Distinctive Numbers"

You need different time durations for calculating the OEE distinctive numbers. In this configuration screen form, you specify how the system calculates these time durations from the acquired status conditions.

In TreeView, open the "OEE distinctive numbers" entry and choose the "Calculation of OEE distinctive numbers" sub-entry.

Data of the screen form:

- **Status group:**
  Here, you can choose the individual status groups. You must carry out configuration separately for each status group.

- **Table:**
  All the defined status conditions of the status group are entered in the table. An "X" means that this status belongs to this time duration.
  - If you are working **with the works calendar**, the system displays on the right next to the table a check box list for the **time types** and assigns the selected time types to it. Detailed information see paragraph "Time types selection" later on in this chapter.

Meanings of the columns in the table:

- **Planned assignment time**
  This is the time in which the machine should be working according to the works calendar.
  - If you are running your system **without a works calendar**, the system calculates the planned assignment time by totalizing the time durations of the checked status conditions.
– If you are running your system with a works calendar, only the status conditions of the configured time types (e.g. "Working Time", "Total time") are considered. In the standard, the planned assignment time is used in the formulae for rate of utilization, availability and performance.

• If you are running your system without a works calendar (WITH_SHIFT = 0), the system totalizes for the planned assignment time the time durations of the status conditions that were checked in configuration of OEE distinctive numbers in column "Planned assignment time". To do this, the system totalizes the times of the checked status conditions in tables "SCHICHTSUMME", "TAGESSUMME", etc.

If you are running your system with a works calendar (WITH_SHIFT = 1), only the status conditions of the configured time types (e.g. "Working Time", "Total time") are considered.

• **Productive time**
  This is the time in which the machine was working productively.
  Here, you must check all the status conditions where the machine worked productively. In the standard, the useful running time is used in the formula for rate of utilization.

• **Gen. Failure:**
  To calculate the MTBF (reliability) and the MTTR (overhaul), you need the number and durations of the disturbances.
  In this column, check all the status conditions that represent technical disturbances. In this case the selections in the two columns General disturbance and Technical disturbance are identical. If required you may add organizational or other disturbances like Maintenance or Cleaning to the general disturbances.

• **Techn. Failure:**
  To calculate performance and availability, you need the duration of technical standstills.
  In this column, check all the status conditions that represent technical disturbances.

**Time types selection:**
It’s only possible to select time types, if you work with MDA works calendar.
In MDA works calendar you have to assign each time period one of four time types (working time, break, free time, maintenance).
In MDA evaluation when calculating statistical (shift, week, month, year) oee distinctive numbers, only periods of **time types selected** are taken into consideration. If you select "total time" all time types and therefore the complete period will be regarded in the evaluations. For example, if you select "working time" and evaluate statistical data, you can gather the oee distinctive value of the working time. Breaks, free times and maintenance will be excluded from the calculations.

In contrast to evaluations of statistical data, evaluations of period "**current** don't consider selected time types. Total time period will be evaluated in any case.
Selection of the time types impacts all status groups and therefore all working centers.

**Operator inputs in the screen form:**
Choose the desired status group in the pick list.
In the table, check the Transfer status conditions in each column. While you are making changes in the table, the "status group" selection is locked until you either store or discard the data.
Save your data using "Save changes". After this, you can choose another status group.
Configuration changes affect evaluations after a restart of user interface MDA machine evaluations.
**Mark area:**
In the table, you can also check a whole row or a whole column or area at once. First select
- a whole column by clicking on its header,
- a whole row by clicking on the first column in the row or
- an area by clicking an holding down the left mouse button and dragging the mouse pointer over the desired area.
After this, you can check or clear the selected area using the F6 function key.

**Pushbuttons in the footer:**
Pushbuttons that are used by the screen forms:
- F2 function key - ‘Save changes’
- F4 function key - ‘Reject changes’
- F6 function key - ‘Check or clear selected entries’
- F8 function key - ‘Back to main screen’

See also the Chapter entitled
“Calculating the OEE Distinctive Numbers” on page 58.
Configuring “MDA Status Conditions” on page 37
2.18 Calculating the OEE Distinctive Numbers

Formulae for OEE distinctive numbers:

The OEE distinctive numbers that are provided for in the standard are calculated according to the following formula:

\[
\text{Rate of utilization} = \frac{T_{PROD}}{T_{TARGET}} \times 100\%
\]

\[
\text{Availability} = \frac{(T_{TARGET} - T_{ST})}{T_{TARGET}} \times 100\%
\]

\[
\text{Performance} = \frac{\left( \sum_{\text{Material}} \left( \text{Total qty.}_{\text{Material}} \times \text{Target cycle time}_{\text{Material}} \right) \right)}{(T_{TARGET} - T_{ST})} \times 100\%
\]

\[
\text{Quality} = \frac{\left( \sum_{\text{Material}} \left( \text{Total pcs.}_{\text{Material}} - \text{Scrap qty.}_{\text{Material}} \right) \right)}{\left( \sum_{\text{Material}} \text{Total qty.}_{\text{Material}} \right)} \times 100\%
\]

\[
\text{OEE}_{\text{Machine}} = \text{Availability} \times \text{Performance} \times \text{Quality} / 1,000,000
\]

\[
\text{MTBF} = \frac{T_{PROD}}{\text{Number of disturbances}}
\]

\[
\text{MTTR} = \frac{T_{SA}}{\text{number of disturbances}}
\]

Meanings of abbreviations:

\(T_{PROD}\) = The useful running time is the time in which the machine was working productively

\(T_{TARGET}\) = The planned assignment time is the time in which the machine should be working according to the works calendar

\(T_{ST}\) = Techn. Failure: This is the time in which the machine was technically disturbed

\(T_{SA}\) = Gen. Failure: This is the time in which the machine was disturbed

These four time periods \((T_{PROD}, T_{TARGET}, T_{ST}, T_{SA})\) are calculated from time periods of status conditions acquired in MDA. Which of these status conditions is added to which kind of time period you customize by mask Configuring "Calculation of OEE Distinctive Numbers".

\(MTBF\) = Meantime Between Faults. This is the average time period between two general failures.

\(MTTR\) = Meantime To Repair. This is the average time period to repair a general failure.

\(Qty\) = Quantity

Note: For projects there is a possibility to calculate and display additional distinctive numbers.

Parameters in the configuration data:

The program reads the parameters below from the configuration data:

- Flag indicating whether the system runs with a works calendar:
  \(\text{General settings} \rightarrow \text{GLOB} \rightarrow \text{WITH\_SHIFT}\)
  This parameter specifies how the planned assignment time is determined, see below.

- Flag indicating whether the system runs with machine data or part type data (piece counts, part types) acquired:
  \(\text{General settings} \rightarrow \text{OEE\_CALC} \rightarrow \text{CALCULATION\_MODE}\)
  This parameter specifies how the piece counts and the target cycle time are determined, see below.

Determining the planned assignment time \(T_{TARGET}\):

- If you are running your system \textit{without a works calendar} \((\text{WITH\_SHIFT} = 0)\), the system totalizes for the planned assignment time the time durations of the status conditions that were checked in configuration of OEE distinctive numbers in column "Planned assignment time".
To do this, the system totalizes the times of the checked status conditions in tables "SCHICHTSUMME", "TAGESSUMME", etc.

- If you are running your system with a works calendar (WITH_SHIFT = 1), additionally only status conditions of the configured time types (e.g. "Working Time", "Total time") are considered.

Determining piece counts for distinctive numbers "Performance", "Quality" and "OEE":

- If you are running your system with PDA acquisition (CALCULATION_MODE = 1), the system totalizes the piece counts of yield, scrap and rework counters from part type data acquired.
- If you are running your system without PDA acquisition (CALCULATION_MODE = 0), the system totalizes the piece counts of yield, scrap and rework counters from machine data acquired.

Determining target cycle time for distinctive numbers "Performance" and "OEE":

- If you are running your system with PDA acquisition (CALCULATION_MODE = 1), the system totalizes the target cycle time of the part types from part type data acquired. Some working centers do not provide the target cycle time. In this case the current cycle time will be totalized.
- If you are running your system without PDA acquisition (CALCULATION_MODE = 0), the system uses the machines target cycle time for calculating the performance.

Notes:

- Impacts determinations of piece counters and planned assignment time:
  In one plant if there are working centers with and without acquisition of part types, you can specify a "mixed mode" (CALCULATION_MODE = 2). If this mode is customized, property "Type of automatic acquisition" of a work center determines, which kind of counters are totalized. If the automatic acquisition of a work center is set to "PDC Acquisition" or "MDC+PDC Acquisition", the counters are gathered from the part type data acquired. Otherwise the counters are calculated from the machine data acquired.
- If there is no data in the status tables for a time range, all the OEE distinctive numbers are set to "0".
- If you are running your system with PDA acquisition and there is no data for a time range in the PDA tables, the system sets to "0" the OEE distinctive numbers for quality and performance, which also sets the OEE distinctive number to "0".
- If the planned assignment time $T_{TARGET}$ is the same as the time for technical disturbances $T_{ST}$, the performance is set to "0".
2.19 Configuring "Display of OEE Distinctive Numbers"

In this configuration screen form, you specify the OEE distinctive numbers, which external program "OEECalculate" calculated, you want to have displayed in the table and in the graphic.

In TreeView, open the "OEE distinctive numbers" entry and choose the "Display of OEE distinctive numbers" sub-entry.

Data of the screen form:
You enter in the table all the configured OEE distinctive numbers with their parameters.

Meanings of the columns in the table:

- **No.:**
  Serial number. You enter the OEE distinctive numbers in this order in the table and the graphic in the "OEE distinctive numbers" evaluation screen form.

- **Key:**
  Unique identifier of the OEE distinctive number. The external program "OEECalculate" stores the OEE distinctive numbers under this identifier in the database.

- **Des. key and designation:**
  Des. key is the key for the designation text.
  In the "Designation" column, you can enter the actual designations of the OEE distinctive number in the individual languages.
  The designations are stored under Des. key in table "TEXT_MASKS" of MDA's configuration database.

- **Unit:**
  Optionally, enter here the unit in which the system is to calculate and display the OEE distinctive number. This unit is also displayed as a comment.
• **Conversion:**
  In general, the system calculates the OEE distinctive numbers as a value and writes them to the database. Here, you can specify how the value is to be formatted for display in the table of the evaluation screen form.

• **In graphic?:**
  Here, choose whether you want the OEE distinctive number to be displayed in the table only, or in the evaluation screen form's graphic too.

• **Min. and Max.:**
  Only if the OEE distinctive number is displayed in the graphic:
  The minimum and maximum values for the OEE distinctive number. The system then scales the values of the OEE distinctive number appropriately such that "Minimum" corresponds to the "0%" value of the Y axis and "Maximum" to the 100% value of the Y axis.

• **Color:**
  Only if the OEE distinctive number is displayed in the graphic:
  The color of the OEE distinctive number in the graphic.
  Note: The color "black" is displayed with a dark-blue background.

**Operator inputs in the screen form:**
To configure a new OEE distinctive number, click on the blank row at the end of the table. To change the data of a new OEE distinctive number, click on the corresponding row in the table. Use the input fields below the table to change the data of the OEE distinctive number.

**Entering the designation of the OEE distinctive number:**
First, enter the text key for the designation in column "Des. key". If this foreign language text already exists, the system enters in column "Designation" the current text in the current language. In the "Designation" column, change the designations for the OEE distinctive number for all the languages that you need. This means that when you save the changes, the system saves the designation in all the entered languages.

**Pushbuttons in the footer:**
Pushbuttons that are used by the screen forms:
  • F2 function key - ‘Save changes’
  • F4 function key - ‘Reject changes’
  • F6 function key - ‘Delete OEE distinctive number’
  • F8 function key - ‘Back to main screen’

See also the Chapter entitled “Calculating the OEE Distinctive Numbers” on page 58.
2.20 Starting Without Login

By means of configuration, you can set up the respective user interface such that it starts without you needing to log in.

By making the following entries in

```
General Settings → PRJ_USER
```

you can specify whether the system displays the login screen at start-up or the login with which automatic login in is carried out:

- **LOGIN_ACTIV 0** - No login screen is displayed at start-up
  - Otherwise - Login screen is displayed at start-up
- **LOGIN_CLASS** - User name to use if you start up without a login screen.
  - This entry is only used if "LOGIN_ACTIV = 0".

Even if you started the user interface without a login screen, it is possible to log in under another user group at any time using the "File -> Login Screen" menu or the "Login Screen" pushbutton. When you have done this, the system uses the settings and Users of this user group.

2.21 Language Selection

The texts of the screen forms can be displayed in various languages.

You change languages using menu item "Options->Language".

This function is not available on the SINUMERIK.

2.22 About

The "Help->About" menu item displays a window containing the version number of the product.

This function is not available on the SINUMERIK.

2.23 Display Help

Shows the context sensitive help of the current screen.

This function is only available on the SINUMERIK in service mode.
3 Configuring a Multistage Mimic Screen

Functionality of MDA Plant.

3.1 Structure and Options in the Multistage Mimic Screen

Functionality of MDA Plant.

The multistage mimic screen is for visualizing the status conditions of stations and areas as well as of the piece counters of stations in relatively large plants.

Each mimic screen consists of:

- a background graphic:
  A "*.bmp" bitmap format file that you can use to load any graphic you like as the background image.

- Symbols:
  A symbol can display the data of a station or an area or a group.

- Successor images:
  For each icon, you can optionally state a successor image that you can call by double-clicking on the icon or by right-clicking on the icon and choosing "Subimage" in the context menu. This allows you to implement hierarchical and network-like structures of mimic screens.

You use the configuration to specify the following:

- Which background graphic the system loads with a mimic screen.
- Which icon the system displays in the respective mimic screen.
- Which station, buffer or which area/group the system visualizes with an icon.
- Whether the system displays the 'Good', 'Scrap' and 'Rework' piece counters.
- Whether the system displays the buffer specific 'import' and/or 'export' piece counters.
- Whether the system displays the status text.
- Whether the system displays in image as a subimage and if so, which one.
- Which magazine a buffer is assigned to.

Information with the symbols:

Each symbol can display the following information:

Designation of the station:
If you assigned a designation to the symbol at configuration, the system displays this designation. Otherwise, the system outputs the name that is assigned to the station.

**Color of the status:**
The system outputs the current status of the station as a color in the rectangle. The system always displays in white symbols to which no stations have been assigned and which are only for displaying subimages.

**Designation of the status:**
As an option, the system outputs the designation of a status below the rectangle containing its color. You can specify for each symbol whether the system is to display the status designation or not.

**Marking frames:**
If the symbol is currently selected, the system displays a frame around it. In the configuration, you can set the thickness and color of the frame:

"General Settings → GUI_MON → LAYOUT_SELECTCOLOR"
"General Settings → GUI_MON → LAYOUT_SELECTWIDTH"

**Good piece count / scrap / rework:**
You can configure for each symbol which of these counters it is to display.
The counters are taken from table "APLZ_STAMM":
- Good piece count: DE_SCHICHT_A
- Scrap: DE_SCHICHT_B
- Rework: DE_SCHICHT_C

As an alternative, you can have the system display the other three values from table "APLZ_STAMM". To do this, you must enter the data below in the configuration database in table "GLOBAL_PARA":

- SECTION = GUI_MON PAR_NAME = VALUE_OK
- SECTION = GUI_MON PAR_NAME = VALUE_NOK
- SECTION = GUI_MON PAR_NAME = VALUE_REW

In column "PAR_VAL", you enter the respective column from table "APLZ_STAMM" whose value you want to display on the mimic screen.

**Symbol for communications disturbance:**
In the configuration, you specify whether the system is to display the yellow triangle with the symbol of the station if the connection from the host computer to the station is interrupted. Field PDA_LINE_CHECK in table APLZ_STAMM is evaluated.

In every buffer symbol there can be displayed following data:
- buffer name
- import piece counter
- export piece counter
- empty buffer places
- remaining work piece
  - work piece type 3
  - work piece type 2
  - work piece type 1
- frame shows selected symbol

**Buffer name:**
If a description was given to the symbol during configuration this description will be displayed. Otherwise the magazine of the related buffer will be displayed.
Import piece counter:
Sum of work pieces actually imported into the buffer – independent from work piece type.

Export piece counter:
Sum of work pieces actually exported from the buffer- independent from work piece type.

Empty buffer places:
Relatively to the overall buffer size, the number of empty buffer places are visualized.

Work piece type 1..3
Relatively to the overall buffer size, the number of buffer places are visualized occupied by the particular work piece type.
Which real work piece types are related to work piece type 1..3 is configurable for each user in the mimic screen.

Selection Frame:
If the symbol is selected a frame around the symbol will be displayed. Frame weight and color can be changed via customizing:
- "General Parameters → GUI_MON → LAYOUT_SELECTCOLOR"
- "General Parameters → GUI_MON → LAYOUT_SELECTWIDTH"

See also Chapter entitled "Product information "Mimic screen"" on page 87.
3.2 Creating the Mimic Screens

Functionality of MDA Plant.

In TreeView, open the "multistage mimic screen" entry. The system displays all the available mimic screens with their designations.

After you choose an entry, the system displays the screen form for drawing the mimic screen as well as a properties window (see below):

Data of the screen form:

The mimic screens are stored independently of the configuration.

In the background, the system loads the background graphic that is defined for the mimic screen and places on it all the stations with the data that they have to display. Green is used as the status color.

Operator inputs in the screen form:

Using the functions in the footer, you can create a new mimic screen, delete the current mimic screen, insert a new symbol and delete a selected one.

If you select a symbol using the mouse, the system highlights it with a thicker border in a different color. The symbol's data is entered in the properties window, see below.

Changing the position of the symbol:

Select the symbol using the right or the left mouse button. Then left-click on the symbol and keep the mouse button pressed down. By dragging with the mouse, you can move the symbol on the mimic screen. Alternatively, you can also set the symbol's position on the mimic screen directly in the properties window (see below).
Changing the size of the symbol:
Select the symbol using the right or the left mouse button.
Then right-click on the symbol and keep the mouse button pressed down. By moving the mouse, you can change the size of the symbol. Alternatively, you can also set the symbol's size directly in the properties window (see below).

Save the mimic screen you have created by clicking on "OK".

Pushbuttons in the footer:
Pushbuttons that are used by the screen forms:
- F2 function key - ‘OK’ Saves the mimic screen
- F3 function key - ‘Reject changes’ Reread the mimic screen from the database. All your changes are lost.
- F4 function key - ‘New mimic screen’ Displays a blank screen form: you can create a new mimic screen.
- F5 function key - ‘Delete mimic screen’ Completely deletes the current mimic screen with all its symbols from the database.
- F6 function key - ‘New symbol’ Inserts a new symbol in the mimic screen.
- F7 function key - ‘Delete symbol’ Deletes the highlighted symbol.
- F8 function key - ‘Back to main screen'
**Contents of the properties window:**

Contents of the property window when station is selected:

<table>
<thead>
<tr>
<th>Properties of the plant model</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Layout data</strong></td>
</tr>
<tr>
<td>Layout number: 1</td>
</tr>
<tr>
<td>First outlay display</td>
</tr>
<tr>
<td>Comment</td>
</tr>
<tr>
<td>Layout</td>
</tr>
<tr>
<td>Background bitmap</td>
</tr>
<tr>
<td>Bitmaps\Layoutbereich2.bmp</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Symbol data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol number: 1</td>
</tr>
<tr>
<td>Designation</td>
</tr>
<tr>
<td>Width: 120 Pixels</td>
</tr>
<tr>
<td>Height: 15 Pixels</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Visible symbol caption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
</tr>
<tr>
<td>Status name</td>
</tr>
<tr>
<td>Communication flag</td>
</tr>
<tr>
<td>Display good piece count</td>
</tr>
<tr>
<td>Number of rejects</td>
</tr>
<tr>
<td>Number to rework</td>
</tr>
<tr>
<td>Part type</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Assigned area or machine</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area: 2 - Area 2</td>
</tr>
<tr>
<td>Group</td>
</tr>
<tr>
<td>Machine no: 3 - QP 012 - 1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Next layout</th>
</tr>
</thead>
</table>

| Optional                     |
| Select some status conditions|
Contents of the property window when buffer is selected:

Using the properties window, you can change the mimic screen's central data as well as the data of the currently selected symbol.

Operator inputs to the properties window:

**Screen data:**
In this section, you enter the mimic screen's central data:

- **Screen number:**
  Each mimic screen has a unique number. You can assign this number when you create a mimic screen but you cannot change it later.

- **Start screen:**
  Set this flag for the mimic screen that you want to load first at start-up.
• **Comment**
  Enter a comment that will identify the mimic screen in the TreeView of configuration.

• **Background bitmap:**
  If you want to use a background graphic on the mimic screen, enter the name and path of the bitmap file here. You can only use ".bmp" files.
  The pushbutton to the right next to the field opens a file dialog in which you can choose and load the bitmap file.
  In the plant, it is advisable to store all the bitmap files in the following bitmap directory
  General Settings ➔ GUI_MON ➔ PATH_BITMAPS
  In this case, you do not need to state a path with the bitmap files.

**Symbol data:**
In the rest of the sections, you specify the data of the respective symbol:

• **Symbol number:**
  Each symbol is given an internal symbol number. You cannot change this number.

• **Designation:**
  As an option, you enter here a fixed designation for the symbol.
  If you leave the field blank and you want to display a designation (see below), you use the name of the assigned station or the name of the assigned range or group.

• **Position:**
  The X and Y coordinates of the symbol on the mimic screen in pixels.
  The zero reference point is the top left corner of the mimic screen.
  If you move the symbol using the mouse, the system enters here the current position of the symbol.
  Alternatively, you can also enter a position directly in these fields. When you exit the fields, the system moves the symbol to this position on the mimic screen.

• **Width and height:**
  Width and height of the symbol in pixels.
  If you change the size of the symbol using the mouse, the system enters here the current size of the symbol.
  Alternatively, you can also enter the width and height directly in these fields. When you exit the fields, the system changes the symbol to this size.

• **Display designation:**
  Using this flag, you specify whether you want to output the symbol's designation above it.

• **Successor image:**
  For each symbol, you can optionally state a successor image that you can call by double-clicking on the symbol or by right-clicking on the symbol and choosing "Subimage" in the context menu.
  This allows you to implement hierarchical and network-like structures of mimic screens.
  If required, choose one of the already defined mimic screens as the successor image.

• **Select status conditions**
  This pushbutton is only active with symbols to which a single station is assigned.
  The default setting is that the system displays for the symbol the pending status with the highest priority of the assigned station or area.
  Using this pushbutton, you can display a follow up screen form for choosing the individual status conditions. In this case, the following applies:
  – If one or more of the selected status conditions are pending at the station, the system displays the selected status with the highest priority.
  – If no selected status is pending, the system takes white as the status color and does not display a status text.
Station symbol

- **Communications flag**
  Using this flag, you specify whether you want to display the symbol for the connection status.

- **Display piece counts: Good, Scrap, Rework**
  Using this flag, you specify whether you want to display piece counters to the right of the symbol and if so, which ones.

- **Display status designation:**
  Using this flag, you specify whether you want to output the current status's designation below the symbol.

- **Display part type designation:**
  Using this flag, you specify whether you want to display the current part type.

- **Assigned area/machine:**
  You can assign to each symbol either an area, a group or an individual machine.
  - **Area:**
    To assign an area to the symbol, choose one of the defined areas; with group, choose "***" and leave the APLZ-Nr blank.
  - **Group:**
    To assign a group to the symbol, choose one of the defined areas and below it one of the defined groups of the area and leave the APLZ-Nr blank.
  - **APLZ_Nr:**
    To assign an individual station to the symbol, choose "***" for the area and group and the desired station with APLZ-Nr.

  If you only want to use a symbol to display subimages, do not assign a station to this symbol. Choose "No assignment" in one of the pick lists. The system then automatically sets all the other pick lists to "No assignment".

  With these symbols, it is not possible to display any data (piece counts, etc.) apart from the symbol name.

Buffer symbol

- **Import / Export piece counter:**
  With these flags you define to display the import and/or export piece counter.

- **Buffer size:**
  Here you define, how many work pieces to place into the buffer. This information is used for drawing the buffer's filling level in the mimic screen.

Determining the status with the highest priority with areas and groups:

In the case of symbols to which a single station is assigned, the system determines the highest-priority status by means of the status's "Priority" attribute.

In the case of symbols to which an area or a group is assigned, the system determines the highest-priority status by means of the status's "Group priority" attribute. Using this group priority, you can specify above and beyond single stations how high the priority is for the area or group.

See also Chapter entitled:
“Structure and Options in the Multistage Mimic Screen” on page 63
“Product Information "Mimic screen"” on page 87.
4 Configuring Data Transfer

4.1 Information on Data Transfer

It is possible either cyclically or on a triggered basis to match the contents of database tables between a

group PC and acquisition stations (PCs or networked acquisition stations like SINUMERIKs and Operator

Panels).

To do this, you start the background program "MdeTransfer" on the group PC and the acquisition stations

that carries out the configured data Transfer processes.

Conditions for data Transfer:

- The database tables must have identical structures on the group PC and the acquisition stations.
- The group PC and the acquisition stations must be networked via TCP/IP.
- The group PC must share two directories for the transfer. A directory to which the acquisition

stations write the data for the group PC and a directory in which the group PC stores the data for

the acquisition stations.

You configure the path to these directories in the "general parameters" under "MDE_TRANSFER".

This chapter describes the configuration screen forms for data transfer.

The data is subdivided as follows:

- **Computer name:**
  Designations of all the acquisition stations and the group PCs on the Windows network

- **Database tables:**
  General data for all the database tables that are to be matched.

- **Transfer jobs:**
  Configurations of the actual transfer jobs.
  These consist of three parts:
  - Header data: Designation of the transfer and when it is to be carried out
  - SQL statements: For each table to be transferred, a SQL statement defines which data is to be

  transferred.
  - Target stations to which data is to be transferred
4.2 Available Transfer Modes

One of the following transfer modes is assigned to each transfer job. Depending on the transfer mode, the system transfers different columns of the table and books them into the table on the target station in a different way.

You highlight the columns in the "Data transfer → DB tables" screen form.

You specify the transfer mode in the "Data transfer → Transfer jobs → header data" screen form.

The following applies to all the modes except for "Delete job": The system transfers all the columns that are marked "Target", "Actual" or "Key".

- **'Basic supply' transfer mode**
  On the target computer, the system deletes the table and takes into the table all the columns that are marked "Target", "Actual" or "Key".

- **'Update/new data' transfer mode**: First of all, the system checks on the basis of the columns marked "Key" for each of the transferred data records whether the data record already exists. If the data record already exists on the target computer, the system only applies the data of the columns that are marked as "Target" data. If the data record does not yet exist on the target computer, the system applies the data of the columns that are marked as "Key" "Target" or "Actual".

- **'New data' transfer mode**: The system applies on the target computer the data of the columns that are marked as "Key", "Target" or "Actual" without checking this data. You must only use this mode if you are absolutely certain that only new data is being transferred that is not yet present on the target station.

- **'Synchronization' transfer mode**: First of all, the system checks on the basis of the columns marked "Key" for each of the transferred data records whether the data record already exists. If the data record already exists on the target computer, the system only applies the "Target" data. If the data record does not yet exist on the target computer, the system applies the "Key" "Target" and "Actual" data. In addition, the system deletes all the data that is present on the target computer and that was not transferred. To be able to do this, the table on the target computer must contain column "TRANS_FLAG".

- **'Delete job' transfer mode**: In this case, a differentiation must be made between whether you entered in the header data of the transfer job under direction "Delete local" or "To group PC" or "To acquisition station".

  In the case of the "Delete local" direction, no data is transferred to a target computer; rather, the SQL statement is used to locally delete data from tables. You define the SQL statement for deleting in the "Data Transfer → Transfer jobs → SQL statements" screen form.

  If you enter "To group PC" or "To acquisition station" as the direction, the system transfers the data records to the acquisition station in the usual way and deletes all the transmitted data records there. When doing this, the system only evaluates the "Key" columns.
4.3 Data Transfer – Computer Names

Designations of all the acquisition stations on the Windows network

**Default setting of the screen form:**
When the screen form is displayed, all the computer names with the PC numbers are entered.

**Operator inputs in the screen form:**
In the screen form, you can
- change the name of a station,
- define a new station and
- delete stations that are no longer needed.
- You have to specify a configuration name for each station.

The PC number is used for internal management purposes only and the system assigns it automatically. If you choose a row in the list, the system enters the data of the row in the fields below the table. There, you can change or specify the computer name of the station and the name of the configuration.

You have to specify a configuration name with the stations. At automatic or manual triggering of data transfer, the system transfers to this station only the configuration data of the specified configuration. This makes it possible to prevent stations from accidentally receiving data from incorrect configurations, e.g. preventing acquisition stations from getting configuration data for the group PC.

After clicking on the "OK“ pushbutton, the system saves the table’s data.
Pushbuttons in the footer:

Pushbuttons that are used by the screen forms:

- F2 function key - ‘OK’ Saves the data
- F3 function key - ‘New entry’ Inserts a new row in the table
- F4 function key - ‘Delete entry’ Deletes the selected station
- F8 function key - ‘Back to main screen’

You can define parameters for SQL statements for every station with every transfer job.
When you delete a station, all its data is also deleted from the transfer jobs.
Attention: Already existing transfer files won't be deleted automatically from the transfer directory.
4.4 Data Transfer – Database Tables

General data for all the database tables that are to be matched.

**Default setting of the screen form:**
When the screen form is displayed, the data of the database table that is selected in the Tree is entered. You enter in the table all the column names that are used to select the database table.

**Operator inputs in the screen form:**
In the screen form, you can
- change column definitions of a database table,
- include a new database table, and
- remove database table that are no longer needed from the configuration.

The database tables are identified by means of the table number. After this, you can enter a comment to the database table.

In the "Database file" field, you enter the name of the database in which the database table is saved. Entries that start with a dollar sign ("$") refer to entries in the "MdeServer.ini" file, which are replaced at runtime by the name that is entered there.

In the "Table type" pick list, you can specify a type for database tables. Depending on the type, the transfer program carries out specific actions when writing the transfer data.

Example: After transferring works calendar data, MDA informs the background programs that new works calendar data is present.

Always set the table type for your transfers to "0 - normal". The other table types are only needed for special solutions in projects.
In the "DB table" field, you can choose the desired table from the ones in the database.

Optionally, you can define an "Acknowledgement flag" and an einen "Acknowledgement value". If you define a column in the table as an acknowledgement flag, the system enters the acknowledgement value in the column that is defined as the acknowledgement flag after transferring a data record of this database table.

You can also query the column that is defined as the acknowledgement flag in the table's SQL statement. This means that data records are only transferred once.

In the table, you mark the columns to be transferred:

- **Key**
  - You must mark all the columns as key fields that are part of the table's primary key.

- **Target**
  - Mark the column as a field containing a specified value.

- **Actual**
  - Mark the column as a field containing an actual value.

The system evaluates the marked columns depending on the transfer mode, see the Chapter entitled “Available Transfer Modes” on page 73.

After clicking on the "OK" pushbutton, the system saves the screen form's data.

**Pushbuttons in the footer:**

Pushbuttons that are used by the screen forms:

- F2 function key - ‘OK’ Saves the data
- F4 function key - ‘Delete entry’ Deletes the configuration of the database table
- F8 function key - ‘Back to main screen’

You configure new database tables by entering a new database number between 1 and 899. The contents of the screen form are cleared then.

Table numbers from 900 to 999 are reserved for the internal transfer jobs of MDA.

You can also include the same table several times under different numbers, for example to mark different columns in the table depending on the transfer mode.
4.5 Transfer Jobs – Header Data

Only relevant for MDA Plant.

Designation of the transfer job and when it is to be carried out

**Default setting of the screen form:**
When the screen form is displayed, the data of the transfer job that is selected in the Tree is entered.

**Operator inputs in the screen form:**
In the screen form, you can
- change the data of a transfer job
- define a new transfer job, and
- delete transfer jobs that are no longer needed.

**Transfer number and designation:**
Transfer jobs are identified by transfer job numbers. You can enter a comment for each transfer job.

In the "Direction" field, you specify
- whether the data transfer is to go from the group PC to an acquisition station, or
- from an acquisition station to the group PC, or
- whether it is a local delete job.

In the "Mode" field, you specify the transfer mode, see the chapter entitled “Available Transfer Modes” on page 73.
In the "Period" area, you define how the transfer job is to be carried out:

- ‘On triggering’ means that the transfer job is only carried out if you trigger it by means of the ‘File -> Start data transfer’ screen form.
- In the case of ‘Cyclically’, you specify the time interval (1 minute to 9999 minutes) in which data transfer is to be carried out cyclically.
- In the case of ‘periodically’, you specify that the data transfer is either to be carried out on a daily basis at a specific time or once a week on a specific day of the week at a specific time.

**Number of log files:**
If log mode is activated in "General parameters → MDE_TRANSFER", the system logs each data transfer that is carried out. One log file is written per executed data transfer. Using the number of log files, you can specify how many log files are to be retained for this data transfer.

After clicking on the "OK" pushbutton, the system saves the screen form's data.

**Pushbuttons in the footer:**
Pushbuttons that are used by the screen forms:

- F2 function key - ‘OK’ Saves the data
- F3 function key - ‘New entry’ Defines a new transfer job
- F4 function key - ‘Delete entry’ Deletes the selected transfer job
- F8 function key - ‘Back to main screen’

You can define new transfer jobs by clicking on the "New entry" pushbutton and entering a new transfer number between 1 and 899.

Transfer numbers from 900 to 999 are reserved for the internal transfer jobs of MDA.
4.6 Transfer Jobs – SQL Statements

Only relevant for MDA Plant.

You must use a SQL statement to specify for each table from which data is to be transferred using the transfer job how the data is to be read from the table.

Default setting of the screen form:

When the screen form is displayed, the data of the transfer job that is selected in the Tree is entered. In the Tree, you can see for which tables for this transfer job SQL statements are already defined.

Operator inputs in the screen form:

In the screen form, you can
– store a SQL statement for each database table
– delete tables from the transfer job that are no longer needed.

Apart from this, you can specify a comment for the parameters that you use in the SQL statement. This comment is displayed in the "Data transfer ➔ Target stations" and "File ➔ Start data transfer" screen forms.

The comment can also be a key to a foreign language text in table "TEXT_MASKS". In this case, the system converts the comment via the foreign language table and outputs it in the current language in each case.
Transfer number and designation:
The system displays the number and designation of the currently selected transfer job.

Table no.:
Using this pick list, you can choose one of the defined tables.

SQL statement:
Using this SQL statement, you select the data of the table. The system transfers all the found data to the target station.
The SQL statement can contain the following optional placeholders:
- Placeholders '%P1' to '%P5' are replaced by the parameter data that is defined for one station in screen form "Transfer data - target stations".
- Placeholder '%PCNAME' is replaced by the name of the target station.

If the transfer job is a "Local delete job", you define here a SQL statement that is used to delete the data from the database table: "Delete from ... where ..."

After clicking on the "OK" pushbutton, the system saves the screen form's current data.
Save the screen form every time you enter or change a SQL statement.

Pushbuttons in the footer:
Pushbuttons that are used by the screen forms:
- F2 function key - 'OK' Saves the SQL statement, etc.
- F4 function key - 'Delete entry' Removes the database table from the transfer job
- F8 function key - 'Back to main screen'
4.7 Transfer orders – Target stations

By means of the configuration of the target stations, you configure for each transfer job the target stations to which the data is to be transferred. You can define for each target station up to five parameters that are used in the SQL statement for the tables.

Default setting of the screen form:
When the screen form is displayed, the data of the target station that is selected in the Tree is entered. In the Tree, you see the target stations to which the data of the transfer job is transferred. The "Computer name" pick list contains all the target stations that are defined in "Data Transfer → Computer name". Using this pick list, you can choose another target station.

Operator inputs in the screen form:
In the screen form, you can
– specify the target stations for a data transfer, and
– define for each target station up to five parameters for the SQL statements of the database tables.

After the input fields for the parameters of the SQL statements, the system displays the comment that is defined for the parameters.
If you choose "All computers" in the pick list, the transfer program transfers the data to all the target stations that are defined in "Data Transfer → Computer names" (except to the station at which the transfer job is generated). The parameters are taken for each target station that is defined under "All computers".

If individual target stations are assigned to the transfer job apart from "All computers", the system ignores these configurations of the individual target stations.

The following special rule applies to transfer numbers greater than 900:

If "Name of configuration" is needed as the first parameter and you specified a configuration name when defining the station name, the system takes the configuration name that is defined there rather than the one that is entered in this screen form.

After clicking on the "OK" pushbutton, the system saves the screen form's data.

Pushbuttons in the footer:

Pushbuttons that are used by the screen forms:

- F2 function key - 'OK' Saves the data
- F4 function key - 'Delete entry' Removes the target station from the transfer job
- F8 function key - 'Back to main screen'
5  General Information on Handling

5.1  Information on Using the Mouse

All the information about the right and left mouse buttons refers to the default settings for the mouse for right-handed users that are stored in the Windows Control Panel! If you have reversed the settings of the mouse buttons for left-handed people, take this into account when making the described inputs.

5.2  The Help System

In the MDA applications, you have a help system available that you can use at any point while working with the programs. To call the help system, simply press the F1 function key on the top row of the keyboard.

The help system is context-sensitive, i.e. you are always provided with help that is relevant to the screen form in which you are currently working. When you press the F1 function key to start the help system, it always provides an explanation to the screen form where you are located at the time.

Single-clicking terms that are underlined takes you to the desired topic; single-clicking the Back pushbutton takes you back to the topic that was displayed previously. The "Back" pushbutton is located at the top of the window under the menu bar.

On the left side of the back button there is a button called "Show" respectively "Hide". By pressing this function key you can show or hide the contents of this help document.

Below the helptext there are two buttons. Pressing the left arrow button moves to the previous chapter, pressing the right arrow button moves to the next chapter.

The help system is not available on the SINUMERIK.
5.3 Traces and Error Messages

Using the configuration of "Theme related Settings", you can activate traces for the user interfaces and the servers. To do this, set the respective "TRACE_LEVEL" entry to the desired trace level.

Setting higher numbers for the trace levels means that the system carries out more detailed traces.

The system always writes error messages to the trace files if traces are activated. In-parallel with this, the system writes error messages to the system logbook in the database and you can display them via the "System logbook" screen form.

All the traces are written to MDA sub directory “Errors”.

The trace system always writes three trace files in each case on a circular basis. For this, the system takes the name of the program (for example "GUI_RT") and adds to it the string "_1.txt", "_2.txt" or "_3.txt".

This means that you find three trace files each: "GUI_RT_1.txt", "GUI_RT_2.txt" and "GUI_RT_3.txt".

Important!

You should always work with trace deactivated (trace level “0”).

Depending on the trace level, activating tracing means that the system writes a large amount of data to the trace files and this can lead to a significant loss of performance for the programs.

Traces should only be activated to localize problems and errors.
5.4 Adding a New Foreign Language in MDA

Functionality of MDA Plant! To add you languages to the MDA system, you have to change the structure of several database tables.

All the foreign language texts are stored in the databases.

If you want to add a new foreign language, you must first make the following changes to the tables of these databases.

First specify what you want to call the column containing the foreign language texts in the tables. You must give the column the identical name in all the database tables. Do not use special characters in the column names.

In the description in this chapter, we will show you how to integrate the French language into the system. The column name "FRANCE" is used for French.

All the designations in monospaced type, e.g. "FRANCE" must be replaced by the designations of your new language.

- **‘LANGUAGES’ table:**
  - Insert a new column called "FRANCE" (of type "Text", length 20 characters).
  - Insert a new row:
    
    | PROJ_NAME: | DEFAULT | Name of the configuration |
    | KEY: | FRANCE | Designation of the column for the new language |
    | STATUS: | 1 | Release the language |
    | DEUTSCH: | französisch | Designation of the new language in German |
    | ENGLISH: | french | Designation of the new language in English |
    | FRANCE: | francais | Designation of the new language in French |
  - In all the other language rows, add column “FRANCE” with the designation of the respective languages in French.

- **Table ‘GLOBAL_PARA’:**
  Insert a new column called "FRANCE" (of type "Text", length 250 characters).
  The comments of the parameters must be translated into the new language.
  Insert a new entry called "MMCLANG_xx".

- **Table ‘TEXT_MASKS’:**
  Insert a new column called "FRANCE" (of type “Text”, length 80 characters).
  The texts of the screen forms must be translated into the new language.

- **Table ‘TEXT_MESSAGES’:**
  Insert a new column called "FRANCE" (of type “Text”, length 200 characters).
  The texts of the messages must be translated into the new language.

- **Table ‘MDEZUSTAENDE’:**
  Insert a new column called "FRANCE" (of type “Text”, length 40 characters).
  The designations of the status conditions must be translated into the new language.

If possible, the texts in tables “TEXT_MASKS” and “TEXT_MESSAGES” should not be much longer than the German ones, since the system cuts off texts in the screen forms if they are too long.

Once you have filled in the "FRANCE" column in all the tables mentioned above, you can use the language in the user interfaces.
6 Product information

This document describes the customizing of MDA in all variants (Cell, Plant, IFC or Machine). For editorial reasons some functions are described which are not part of the product MDA Cell but are intended for use within projects. These chapters are to be ignored for customizing of MDA Cell.

6.1 Product information "Mimic screen"

The functionality "Mimic screen" differs depending on the products „MDA Plant“, „MDA Cell“ and „MDA Machine“. ”MDA Plant“ allows several multistage mimic screens from overview to details and with an optional info screen. „MDA Cell“ and „MDA Machine“ have got a simple mimic screen if running on a PC, not on a SINUMERIK 840D.

6.2 Product information "Configuring Work Centers (Machines, Units)"

The number of definable work centers depends on the product installed:

<table>
<thead>
<tr>
<th>MDA Plant</th>
<th>Unlimited number of machines/units</th>
</tr>
</thead>
<tbody>
<tr>
<td>MDA Cell</td>
<td>Max. 16 machines/units</td>
</tr>
<tr>
<td>MDA Machine</td>
<td>Max. 8 machines/units</td>
</tr>
</tbody>
</table>

All defined work centers need an individual license „MDA Machine“ or „MDA IFC“!
7 Glossary

7.1.1.1.1 Evaluation definition
For the "analysis of reason for disturbance" and "status analysis" graphics, you specify in the evaluation
definitions the status conditions that are to be displayed.
Values "minimum duration" and "minimum frequency" specify how often and for how long a status must
have occurred for it to be displayed.

7.1.1.1.2 User Group
The user group specifies which screen forms and functions are available to users.
User groups are managed via the configuration interface.
You can change the user group by means of the login screen.

7.1.1.1.3 Button bar
The pushbuttons in the footer of the screen form are referred to as the button bar. You can activate
pushbuttons using either the function keys or the mouse.

7.1.1.1.4 Hardcopy
A printout of the current contents of the screen. It can be triggered by means of a configurable function
key.
Default setting:
- SINUMERIK: top function key to the right of the screen.
- Operator Panel: "F9"
- PC: F12 function key

7.1.1.1.5 Main Units
Every machine has a main unit, which describes the status of the machine, and other units that describe
sections of the machine, e.g. feeds. For both, main and sub units data is acquired.

7.1.1.1.6 Main Screen
A screen form from which you can go to all the other screen forms.

7.1.1.1.7 MDA server
The background program "MdeServer" of MDA. It acquires the status conditions of the units and writes
them to the database tables the logbook, the log, ...

7.1.1.1.8 Message Line
The message line is at the bottom edge of the screen form.
The background color shows the type of message:
- Green - Information
- Yellow - User error, warnings
- Red - System error, serious error. There is generally more information in the system
logbook.
7.1.1.1.9 Menu Bar

The menu bar at the top of the window provides functions of the user interface. The menu bar is not available on the SINUMERIK.

7.1.1.1.10 Priority

Each status is given a priority number. Lower priority numbers represent higher priorities. The highest priority a status can be assigned to equals value "0". If more than one status condition pends concurrently, the one with the highest priority (lowest value) will be compressed to statistic data (shift, day, week, year).

7.1.1.1.11 Configuration

In MDA, all the settings are stored in a configuration database and you can customize them by means of the configuration interface.

7.1.1.1.12 Pushbutton

Pushbuttons are displayed on the footers of screen forms. You can operate them using function keys, the mouse or the space bar.

7.1.1.1.13 Start Screen

The screen form that is displayed after start-up and, after possible display of the login screen, that is displayed first.
You can change the start screen via configuration.

7.1.1.1.14 Analysis of reason for disturbance

A screen form of the "MDA machine evaluations" user interface: Display of the status conditions with their duration and frequency for a selected period of time.

7.1.1.1.15 TreeView

Representation of data in a tree structure. The configuration data is represented as a TreeView. Below each of the main entries in TreeView there is the associated data broken down by programs, screen forms, ...

7.1.1.1.16 Compression process

Background program "MdeCompress" of MDA. Cyclically compresses the log data to totals for days, weeks, months and years.

7.1.1.1.17 Availability analysis

A screen form of the "MDA machine evaluations" user interface: Shows the percentage share of the status conditions for a time range and calculates the availability of the machine.
7.1.1.1.18 Status analysis
A screen form of the "MDA machine evaluations" user interface: Shows the course of status conditions for a period of time.

7.1.1.1.19 Status Group
A status group consists of main and sub-status conditions and describes the possible status conditions of a machine or unit type. Exactly one status group is assigned to every machine and every unit.

7.1.1.1.20 Status class
A status class consists of one main status condition, e.g. "disturbance" and possibly several sub-status conditions, e.g. "Blank missing", "Order missing". The status classes of a machine type or an unit type are grouped into a status group.
8 Index

B
Belated reason of disturbance 38

G
General 4–6, 8, 12, 18, 22–24, 29, 46, 49, 55, 57, 60, 61, 63–64, 69, 71, 75, 78, 83
groupings 4, 24–26, 33

L
language 4, 12, 17, 22, 26, 38, 60, 61, 79, 85
Licensing 15

M
MDE_COMPRESS 22
MDE_SERVER 12, 29, 49
MTBF 55, 57
MTTR 55, 57

O
OEE 54–60, 57–58, 57–58, 57–58

P
permissions 47
Printing 8–9

S
Station 28–31, 62–63, 67, 69–70, 72–74, 77, 80–82

T
Traces 84

U
Units 4, 13, 17, 27, 28–29, 35, 86
User Group 5, 16–17, 43–46, 61